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Einleitung
vii
Vielen Dank, dass Sie sich zum Kauf eines Topcon Empfängers, 
Messinstruments oder Zubehörs (nachfolgend "Produkt" genannt) 
entschieden haben. Die Informationen in dieser Bedienungsanleitung 
(nachfolgend “Anleitung” genannt) werden von Topcon Positioning 
Systems, Inc. (nachfolgend “TPS” genannt) für Besitzer von Topcon-
Produkten zur Verfügung gestellt. Diese Anleitung soll Besitzern bei 
der Verwendung der Software (nachfolgend “Software” genannt) 
unterstützen, die mit dem Produkt zu verwenden ist und seine 
Anwendung unterliegt diesen allgemeinen Geschäftsbedingungen 
(nachfolgend “Geschäftsbedingungen” genannt).

HINWEIS
Bitte lesen sie diese Geschäftsbedingungen 
aufmerksam durch.

Allgemeine Geschäftsbedingungen
PROFESSIONELLE ANWENDUNG – Topcon-Produkte 
wurden für die Verwendung durch Fachpersonal entwickelt. 
Der Benutzer muss ein qualifizierter Vermessungsingenieur sein 
bzw. über hinreichende Kenntnisse über Vermessungen verfügen, 
um die Benutzer- und Sicherheitsanweisungen zu verstehen, bevor 
Vermessungen und Einstellungen vorgenommen werden. Bei der 
Verwendung des Produkts ist stets angemessene Schutzkleidung zu 
tragen (Sicherheitsschuhe, Helm etc.).

URHEBERRECHT – Sämtliche Informationen in dieser 
Anleitung sind geistiges Eigentum von TPS und sind 
urheberrechtlich geschützt. Alle Rechte vorbehalten. 
 7010-0522 www.topconpositioning.com
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Die Verwendung, Zugriff, Kopie, Aufbewahrung, Anzeige, 
Schaffung von abgeleiteten Arbeiten, Verkauf, Publikation, 
Distribution oder die Ermöglichung von Zugang durch 
Drittpersonen auf Grafiken, Inhalte, Informationen oder Daten in 
dieser Bedienungsanleitung sind ohne ausdrückliche schriftliche 
Genehmigung von TPS untersagt. Die Informationen in dieser 
Anleitung sind lediglich für die Pflege und Bedienung des Produktes 
bestimmt. Die Informationen und Daten in dieser Anleitung stellen 
wertvolle Vermögenswerte von TPS dar, die unter erheblichem 
Arbeits-, Zeit- und finanziellem Aufwand entwickelt wurden und 
das Resultat eines Auswahl-, Koordinations- und 
Gliederungsprozesses seitens von TPS darstellen.

WARENZEICHEN – Topcon®, Topcon Link™, TopSURV™ 
Und Topcon Positioning Systems™ sind Warenzeichen von TPS. 
Windows® und ActiveSync® sind eingetragene Warenzeichen der 
Microsoft Corporation. Andere in diesem Handbuch erwähnte 
Produkte oder Firmennamen sind eventuell Warenzeichen der 
entsprechenden Eigentümer.

HAFTUNGSAUSSCHLUSS – AUSGENOMMEN DEN IM 
ANHANG ODER AUF EINER IM LIEFERUMFANG 
ENTHALTENEN GARANTIEKARTE VERMERKTEN 
GEWÄHRLEISTUNGEN WERDEN DIESE ANLEITUNG, DAS 
PRODUKT UND DIE MITGELIEFERTE SOFTWARE OHNE 
MANGELGEWÄHR ZUR VERFÜGUNG GESTELLT. 
ES BESTEHEN KEINE WEITEREN 
GEWÄHRLEISTUNGSANSPRÜCHE. TPS SCHLIESST 
JEGLICHE HAFTUNG IN BEZUG AUF DIE ALLGEMEINE 
GEBRAUCHSTAUGLICHKEIT UND EIGNUNG FÜR 
BESTIMMTE ANWENDUNGSZWECKE AUS. TPS UND SEINE 
VERTEILER ÜBERNEHMEN KEINE HAFTUNG FÜR 
TECHNISCHE ODER VERFASSUNGSFEHLER BZW. 
Topcon Topcon Link-Bedienungsanleitung
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AUSLASSUNGEN IN DIESER ANLEITUNG, NOCH FÜR 
ZUFALLS- ODER FOLGESCHÄDEN AUS DER 
BEREITSTELLUNG, LEISTUNG ODER VERWENDUNG 
DIESES MATERIALS, DER SOFTWARE ODER DES 
PRODUKTS. SOLCHE HAFTUNGSAUSSCHLÜSSE BEZIEHEN 
SICH, SIND ABER NICHT BESCHRÄNKT AUF ZEITLICHE 
VERLUSTE, DEN VERLUST ODER DIE ZERSTÖRUNG VON 
DATEN, DEN VERLUST VON GESCHÄFTSGEWINNEN, 
ERSPARNISSEN ODER EINKOMMEN BZW. DEN VERLUST 
DER PROUKTANWENDBARKEIT. AUSSERDEM IST TPS 
NICHT HAFTBAR FÜR SCHÄDEN ODER KOSTEN IM 
ZUSAMMENHANG MIT DER BESCHAFFUNG VON 
ERSATZPRODUKTEN, -SOFTWARE BZW. KLAGEN DRITTER, 
UNBILL ODER ANDERE KOSTEN. IN KEINEM FALL HAFTET 
TPS FÜR SCHÄDEN ODER ANDERE FOLGEN FÜR SIE ODER 
ANDERE NATÜRLICHE ODER RECHTLICHE PERSONEN 
ÜBER DEN KAUFPREIS DES PRODUKTES HINAUS. 

LIZENZVEREINBARUNG – Durch die Verwendung der 
Software und sämtlichen von TPS zur Anwendung mit einem 
Topcon Produkt zur Verfügung gestellten oder von der TPS Website 
heruntergeladenen Computer- oder Softwareprogrammen 
(nachfolgend "Software" genannt) erklären Sie sich mit den 
allgemeinen Geschäftsbedingungen in dieser Anleitung 
einverstanden und verpflichten sich zu deren Einhaltung. Dem 
Benutzer wird eine persönliche, nicht übertragbare Lizenz zur 
Verwendung der Software mit einem einzelnen Produkt oder einem 
Computer unter den hier genannten Bedingungen gewährt. Der 
Benutzer darf eine (1) Sicherungskopie der Software herstellen. 
Ansonsten darf die Software auf keine Art und Weise kopiert oder 
vervielfältigt werden. Die Software oder die Lizenz darf nicht ohne 
ausdrückliche schriftliche Genehmigung von TPS abgetreten oder 
übertragen werden. Die Lizenzvereinbarung gilt bis zur 
Aufkündigung. Der Benutzer kann die Lizenz jederzeit kündigen, 
indem er die Software und die Bedienungsanleitung zerstört. 
P/N 7010-0522 www.topconpositioning.com
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TPS kann die Lizenz ihrerseits kündigen, falls der Benutzer die 
allgemeinen Geschäftsbedingungen nicht erfüllt. Der Benutzer 
erklärt sich bereit, die Software und Anleitung zu zerstören, wenn 
das Produkt nicht länger verwendt wird. Alle Eigentums-, Urheber- 
und andere geistigen Eigentumsrechte in Bezug auf die Software 
liegen bei TPS. Falls die Lizenzbedingungen nicht als tragbar 
angenommen werden, muss unbenutztes Software- und 
Anleitungsmaterial an TPS retourniert werden. 

DISKRETION – Diese Bedienungsanleitung, ihr Inhalt und die 
Software (kollektiv als “vertrauliche Informationen” bezeichnet) 
sind vertrauliche und urheberrechtlich geschützte Informationen 
von TPS. Sie erklären sich hiermit einverstanden, die vertraulichen 
Informationen von TPS mit der gleichen Sorgfalt zu behandeln, mit 
der Sie auch Ihre eigenen wertvollsten Geschäftsgeheimnisse 
schützen. Die Bedingungen in diesem Abschnitt halten Sie jedoch 
keinesfalls davon ab, vertrauliche Informationen mit Ihren 
Angestellten zu teilen, wie dies für die Verwendung und Pflege des 
Produkts notwendig ist. Sämtliche Angestellten verpflichten sich 
ebenfalls zur Geheimhaltung vertraulicher Informationen. Für den 
Fall, dass Sie rechtlich dazu verpflichtet wären, vertrauliche 
Informationen preiszugeben, ist TPS unverzüglich zu informieren, 
so dass TPS entsprechende Schutzmaßnahmen oder andere Mittel 
ergreifen kann.

WEBSITE; ANDERE AUSSAGEN– Keine Aussagen auf der 
TPS Website (oder jeglicher anderer Website) bzw. in anderen 
Anzeigen oder TPS Literatur bzw. durch einen Mitarbeiter oder 
unabhängigen TPS-Lieferanten schränkt diese allgemeinen 
Geschäftsbedingungen (inklusive Software-Lizenzvereinbarung, 
Haftungsausschluss und Haftungsbeschränkung) ein. 
Topcon Topcon Link-Bedienungsanleitung
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SICHERHEIT – Die mißbräuchliche Anwendung eines Topcon 
Produkts kann zu Schäden an Personen oder Eigentum bzw. 
Produktstörungen führen. Das Produkt ist ausschließlich durch ein 
autorisiertes TPS Warranty Service Center zu warten. Die 
Sicherheitshinweise in der mit dem Produkt gelieferten 
Bediengungsanleitung sind vom Benutzer zu studieren und zu 
beachten.

VERSCHIEDENES – Die hier aufgeführten allgemeinen 
Geschäftsbedingungen können durch TPS jederzeit ergänzt, 
verändert, ersetzt oder aufgehoben werden. Die hier aufgeführten 
Geschäftsbedingungen unterstehen und werden ausgelegt gemäß 
der Gesetzgebung des Staates von California, ohne Bezug auf 
Gesetzeskonflikte.
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Manuelle Konventionen
In dieser Anleitung finden folgende Konventionen Anwendung:
Beispiel Erklärung

File->Exit Klicken Sie auf das Dateimenü und dann auf "Exit".
Enter bezieht sich auf die mit "Enter" bezeichnete Taste 

oder Schaltfläche.
Topo bezieht sich auf den Namen des Dialogfelds oder 

Fensters.
Notes bezieht sich auf ein Feld oder Register in einem 

Dialogfeld oder Fenster.

TIP
Zusatzinformationen, die bei der Konfiguration, 
Wartung oder Einrichtung eines Systems hilfreich 
sein können.

HINWEIS
Zusatzinformationen, die eine Auswirkung auf 
den Systembetrieb, die Systemleistung, -
messungen oder persönliche Sicherheit haben.

VORSICHT
Hinweis darauf, dass eine Handlung negative 
Auswirkungen auf Systembetrieb, -leistung, 
Datenintegrität oder persönliche Sicherheit 
haben kann.
Topcon Topcon Link-Bedienungsanleitung
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Einführung
1-1
Topcon Link™ kann für folgende Anwendungen verwendet werden:
• Import von Dateien von konventionellen Topcon 

Totalstationen, robotischen Totalstationen, einem TPS 
Controller und TPS GPS+-Empfänger an einen Computer.

• Ansicht und Bearbeitung von Koordinaten- und 
Rohdatendateien.

• Neuorganisierung von Koordinaten- und Rohdatendateien in 
folgende Formate:

• Erstellen (Bereitstellen) und Export von Koordinatendateien 
von einem Computer an einen TPS Controller und/oder eine 
Totalstation.

Tabelle 1-1. Topcon Link-Dateiformate

–TopSURV
–GIS (DXF, LandXML, Shape)
–Topcon TS Rohformate (GTS-6, GTS-7, 

GTS-7+, FC-5, 
GTS-210/310)

–Topcon TS Koordinatenformate
(GTS-7, FC-5, GTS-210/310-10, GTS-
210/310-12)

–Koordinatenformate mit Trennzeichen 
(Name,Lat,Lon,Ht,Code; 
Name,N,E,Z,Code; Name,E,N,Z,Code; 
Custom)

–TSV ASCII Koordinatenformat
–TDS Koordinatenformat (CR5)
–RINEX
–TPS Empfänger-Datenformat (TPD)
–Topcon XML
–Topcon Geoiddatei
–Topcon GPS-Vektorformat
–Featuredatei
 7010-0522 www.topconpositioning.com
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Installation von Topcon Link
Die Topcon Link Software wird zur Installation auf einem 
Computer auf einer CD geliefert.
1. Legen Sie die Topcon Link CD in das CD-ROM-Laufwerk ein. 

Der InstallShield® Wizard erscheint.
2. Klicken Sie im Dialogfeld des Topcon Link Installations-

assistenten auf Next , um den Installationsprozess zu starten.
3. Bestätigen Sie das Dialogfeld der Lizenzvereinbarung mit Yes  

(Abbildung 1-1). Wird die Vereinbarung nicht angenommen, 
wird die Installation abgebrochen.

Abb 1-1. Lizenzvereinbarung
Topcon Topcon Link-Bedienungsanleitung
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4. Geben Sie im Dialogfeld der Kundeninformation den Namen 
des Benutzers und der Firma ein und klicken Sie auf Next 
(Abbildung 1-2).

Abb 1-2. Eingabe von Kundeninformationen

5. Klicken Sie im Dialogfeld "Choose Destination Location" auf 
die Option Browse, um den Ordner für die Installation von 
Topcon Link auszuwählen bzw. einen neuen Ordner hierfür zu 
erstellen. Klicken Sie auf Next (Abbildung 1-3).

Abb 1-3. Auswahl des Zielordners
P/N 7010-0522 www.topconpositioning.com
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6. Wählen Sie im Dialogfeld Select Program Folder einen 
bestehenden Ordner oder erstellen Sie einen neuen Ordner für 
Topcon Link (Abbildung 1-4). Klicken Sie dann auf Next.

Abb 1-4. Auswahl eines Programmordners

Der Installationsvorgang beginnt.
7. Klicken Sie auf Finish, um die Installation (Abbildung 1-5) 

abzubrechen.

Abb 1-5. Installation abgeschlossen
Topcon Topcon Link-Bedienungsanleitung
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8. Erstellen Sie einen Topcon Link-Shortcut (Abbildung 1-6) auf 
dem Desktop Ihres Computers, um das Programm in Zukunft 
schnell aufstarten zu können.

Abb 1-6. Topcon Link-Shortcut

Aufstarten von Topcon Link
Gehen Sie wie folgt vor, um Topcon Link zu starten:

• Klicken Sie auf Start->Programs->Topcon->Topcon Link.
• Doppelklicken Sie auf den Topcon Link-Shortcut auf Ihrem 

Desktop.
Das Topcon Link Hauptfenster wird angezeigt 
(siehe “Hauptfenster” auf Seite 1-6).
P/N 7010-0522 www.topconpositioning.com
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Erste Schritte
Dieser Abschnitt stellt die verschiedenen Funktionen des Topcon Link 
zur Ansicht, Konfiguration und Bearbeitung von Datendateien vor.

Hauptfenster
Das Hauptfenster (Abbildung 1-7 auf Seite 1-6) enthält die 
folgenden Komponenten:

• Titelleiste – enthält Informationen zu Dateipfaden für 
Jobdateien.

• Systemtasten – zum Verkleinern, Vergrößern und Schließen 
des Fensters.

• Menüleiste – enthält Dropdown-Menüs für verschiedenste 
Topcon Toolfunktionen.

• Symbolleiste – enthält Shortcuttasten für häufig 
verwendete Optionen.

• Arbeitsbereich – der Bereich, in dem Dialogfelder, 
Jobdatei-Informationen und Popup-Menüs erscheinen.

• Statusleiste – enthält Informationen über Topcon Tools und 
verschiedene Dateien.

• Datei-Information – gibt beim Öffnen einer Jobdatei 
Aufschluss über Linear- und Winkeleinheit, 
Koordinatensystemtyp und -informationen.

Abb 1-7. Komponenten des Hauptfensters

Work Area
Topcon Topcon Link-Bedienungsanleitung
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Menüleiste
Die Menüleiste gibt über Topcon Tools Zugang zu den meisten 
verfügbaren Optionen in sechs anklickbaren Dropdown-Menüs.

Dateimenü

Das Dateimenü (Abbildung 1-8):
• öffnet, speichert und schließt eine Datei;
• importiert und exportiert Daten;
• konvertiert Dateien aus und in eine Reihe von 

Dateiformaten;
• druckt Informationen von einer aktiven Datei;
• zeigt Konfigurationsparameter von Jobdateien an;
• zeigt kürzlich verwendete Dateien an.

Abb 1-8. Dateimenü
P/N 7010-0522 www.topconpositioning.com
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Editmenü

Das Editmenü (Abbildung 1-9):
• macht die letzte Operation rückgängig oder wiederholt 

sie oder löscht alle Änderungen;
• schneidet Informationen aus, kopiert, fügt ein oder 

löscht sie;
• zeigt das Dialogfeld "Properties" an.

Abb 1-9. Editmenü

Ansichtmenü

Das Ansichtmenü (Abbildung 1-10) kann die Symbolleiste 
und die Statusleiste anzeigen bzw. ausblenden.

Abb 1-10. Ansichtmenü

Prozessmenü

Das Prozessmenü (Abbildung 1-11):
• berechnet Koordinaten;
• setzt Prozesseigenschaften fest.

Abb 1-11. Prozessmenü
Topcon Topcon Link-Bedienungsanleitung
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Fenstermenü

Das Fenstermenü (Abbildung 1-12):
• schließt alle aktuellen bzw. geöffneten Fenster;
• zeigt geöffnete Fenter in Cascade (stufenförmig) oder 

Tile (nebeneinander) an;
• ordnet Symbole;
• zeigt das aktuelle Fenster an.

Abb 1-12. Fenstermenü

Hilfemenü

Das Hilfemenü (Abbildung 1-13):
• gibt kontextspezifische Hilfe anhand von Hilfsdateien;
• gibt Aufschluss über Topcon Link Version und Datum.

Abb 1-13. Hilfemenü
P/N 7010-0522 www.topconpositioning.com
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Symbolleiste
Die Topcon Link Symbolleiste (Abbildung 1-14) enthält Tasten 
für häufig verwendete Funktionen.

Abb 1-14. Symbolleiste

Beim Programmstart wird die Symbolleiste unter der 
Menüleiste angezeigt. 

• Um die Symbolleiste anzuzeigen bzw. auszublenden, 
klicken Sie auf View->Toolbar. Ein Häkchen zeigt an, dass 
die Symbolleiste aktiviert ist.

• Um die Symbolleiste zu bewegen, klicken Sie darauf links 
neben dem "Open"-Symbol, ziehen Sie sie an die 
gewünschte Stelle und lassen Sie die Maustaste los.

Tabelle 1-2 zeigt und beschreibt die verschiedenen Symbole 
auf der Symbolleiste.

Tabelle 1-2. Funktionen der Symbole

Symbol Beschreibung

Open – öffnet eine Datei.
1. Klicken Sie auf die Schaltfläche, um das Dialogfeld "Open" aufzurufen.
2. Wählen Sie den Dateinamen und/oder wählen sie einen Pfad bzw. 

Ordner auf der Festplatte, einem lokalen Netzwerk oder 
Speichermedium.

3. Klicken Sie auf Open.

Save – speichert Dateien im aktuellen Datenverzeichnis.

Import File from Device – sammelt sämtliche Dateien von TPS GPS+-
Empfängern, TPS Controller sowie konventionellen wie robotischen 
Totalstationen.
1. Klicken Sie auf die Schaltfläche, um das Dialogfeld "Import File 

from Device" aufzurufen.
2. Wählen Sie das gewünschte Gerät und klicken Sie auf Next.

Siehe “Importieren von Dateien” auf Seite 2-1 für weitere Hinweise.
Topcon Topcon Link-Bedienungsanleitung
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Export to Device – exportiert Daten von Dateien an einen TPS 
Controller oder eine konventionelle bzw. robotische Totalstation 
sowie Optionsautorisierungsdateien (Option Authorization File, OAF) 
an TPS-Empfänger.
1. Klicken Sie auf die Schaltfläche, um das Dialogfeld "Export to 

Device" aufzurufen.
2. Wählen Sie das gewünschte Gerät und klicken Sie auf Next.

Siehe “Exportieren von Dateien” auf Seite 2-15 für weitere 
Hinweise.

Convert Files – ruft das Dialogfeld "Convert File" auf. Siehe 
“Dateikonvertierung” auf Seite 3-1 für weitere Hinweise.

Cut – löscht den markierten Textbereich oder Text von der Seite und 
speichert ihn auf dem Windows® Clipboard. 

Copy – kopiert den Text von der Seite und speichert ihn auf dem 
Windows Clipboard. 

Paste – fügt den ausgewählten Text vom Windows Clipboard ein.

Undo – macht das Resultat rückgängig.

Redo – stellt das Resultat wieder her.

Compute Coordinates of Points – berechnet die Koordinaten der 
Punkte in der aktuellen Datei.

Print – druckt das aktuelle Fenster oder die aktuelle Tabelle.

About Topcon Tools – zeigt das Dialogfeld "About Topcon Tools" an.

Tabelle 1-2. Funktionen der Symbole

Symbol Beschreibung
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Hinweise:
Topcon Topcon Link-Bedienungsanleitung



Kapitel 2

P/N
Dateiübertragung
2-1
Dieses Kapitel beschreibt die Verwendung von Topcon Link zum 
Importieren und Exportieren, d.h. Übertragen von Dateien von 
Geräten auf einen Computer.

Importieren von Dateien
Die folgenden Abschnitte beschreiben das Importieren von 
Datendateien von Geräten wie konventionellen/robotischen 
Totalstationen, TPS GPS+-Empfängern oder TPS Controllern an 
einen Computer.
1. Gehen Sie zum Importieren von Dateien wie folgt vor:

• Klicken Sie auf File->Import from Device (Abbildung 2-1). 

Abb 2-1. File->Import From Device

• Drücken Sie F7.
• Klicken Sie in der Symbolleiste auf Import (Abbildung 2-2).

Abb 2-2. Import From Device – Schaltfläche auf der Symbolleiste
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Das Dialogfeld Import from Device erscheint (Abbildung 2-3). 
Dieses Dialogfeld besteht aus zwei Feldern.
•Das obere Feld enthält Symbole für die vier Gerätetypen, von 
denen Rohdatendateien an Topcon Link übertragen werden 
können. Vorerst ist das jeweils zuletzt gewählte Gerät markiert.

•Das untere Feld enthält Anweisungen dazu, wie das Gerät zur 
Dateiübertragung bereitgestellt werden kann.

Abb 2-3. Fenster "Import From Device"

•Um die importierten Dateien nach dem Übertragungsprozess zu 
öffnen, klicken Sie auf Open Files After Import, um diese 
Option zu aktivieren.

•Durch den rechten Mausklick auf ein Gerätesymbol wird ein 
Popup-Menü angezeigt, dass folgende Funktionen ermöglicht 
(Abbildung 2-4 auf Seite 2-3):

– Add a new device: Neues Gerät hinzufügen.
– Cut, copy, delete: Markiertes Gerät ausschneiden, kopieren 

oder löschen.
– Bild auf einem Symbol verändern.
– Einstellen/anpassen der Kommunikationsparameter.
Topcon Topcon Link-Bedienungsanleitung
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Abb 2-4. Popup-Menü eines Geräts

Geräte hinzufügen
1. Um ein neues Gerät aus der Liste "Import From Device" 

auszuwählen, klicken Sie mit der rechten Maustaste in das 
obere Feld, klicken Sie im Popup-Menü auf "Add New 
Device" und wählen Sie den gewünschten Gerätetyp aus 
(Abbildung 2-5).

Abb 2-5. Fenster "Import From Device" – Popup-Menü

2. Geben Sie im Dialogfeld Properties Gerätenamen, 
Bemerkungen, Computeranschluss, Totalstation-Modell 
(falls zutreffend) und Verbindungsparameter ein 
(Abbildung 2-6 auf Seite 2-4).
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Abb 2-6. Eigenschaftfenster von Geräten

3. Klicken Sie in jedem Register auf Apply und bestätigen Sie 
dann mit OK, um die Eigenschaften des neuen Geräts zu 
speichern und das Dialogfeld Properties zu schließen.

Importieren von TPS-Empfängerdateien
Gehen Sie zum Importieren von Daten von einem TPS GPS+-
Empfänger wie folgt vor:

Einrichten der Kommunikationsparameter

Legen Sie im Dialogfeld Import from Device die richtigen 
Kommunikations-parameter fest.
1. Für eine Verbindung zwischen Topcon Link und einem 

TPS GPS+-Empfänger, klicken Sie mit der rechten 
Maustaste auf das Symbol des TPS GPS+-Empfängers.

2. Klicken Sie im Popup-Menü auf  Properties.
3. Wählen Sie den Computeranschluss (seriell oder USB), 

an den der Empfänger angeschlossen ist 
(Abbildung 2-7 auf Seite 2-5).

Totalstation
Register 

Totalstation
Register 

Controller
TPS

Empfänger
TPS

"General" "Advanced"
Topcon Topcon Link-Bedienungsanleitung



Importieren von Dateien

2-5
Abb 2-7. Auswahl des COM-Anschlusses

4. Klicken Sie zuerst auf Apply und dann auf OK, um die 
Informationen zu speichern das Dialogfeld Properties 
zu schließen.

Auswahl der zu importierenden Dateien
5. Klicken Sie im Dialogfeld Import from Device auf die 

Schaltfläche Next .
6. Wählen Sie im linken Feld die gewünschte(n) 

Datei(en) (halten Sie die Shift-Taste gedrückt, um 
mehrere Dateien zu markieren) (Abbildung 2-8).

Abb 2-8. Auswahl der zu importierenden Dateien

7. Navigieren Sie im rechten Feld auf den Ordner, in dem 
Sie die Dateien abspeichern wollen bzw. erstellen Sie 
diesen.
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8. Klicken Sie auf Next. Die Statusleiste zeigt den 
Fortschritt des Importvorgans an (Abbildung 2-9).

Abb 2-9. Fortschritt des Importvorgangs

Falls der Empfänger ausgeschaltet ist oder der falsche 
COM- oder USB-Anschluss ausgewählt wurde, erscheint 
das folgende Dialogfeld (Abbildung 2-10).

Abb 2-10. Fehlermeldung "Cannot Connect"

Klicken Sie auf OK und überprüfen Sie die Anschlüsse des 
Empfängers. Wiederholen Sie den Vorgang erneut.

Importieren von TPS-Controllerdateien
Installieren Sie Microsoft® ActiveSync® auf dem Computer, 
bevor Sie Daten von einem TPS Controller an Topcon Link 
übertragen.  ActiveSync stellt eine Verbindung zwischen dem 
Computer und einem mobilen Gerät wie beispielsweise einem 
TPS Controller her. Das mobile Gerät muss mit dem Windows 
CE-Betriebssystem ausgerüstet sein. ActiveSync kann 
kostenlos von der Microsoft-Website 
(http://www.microsoft.com) heruntergeladen werden.
Gehen Sie wie folgt vor, um die Verbindung zwischen dem 
Computer und dem TPS Controller herzustellen:
1. Schließen Sie den TPS Controller mit einem RS-232 

Schnittstellenkabel an den seriellen Anschluss des 
Computers an.

2. Schalten Sie den TPS Controller und den Computer ein.
3. Starten Sie Microsoft ActiveSync.
4. Klicken Sie im Dialogfeld Get Connected auf die 

Schaltfläche Next. (Abbildung 2-11 auf Seite 2-7).
Topcon Topcon Link-Bedienungsanleitung
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Abb 2-11. ActiveSync – Aufbau einer Verbindung

Der Computer stellt eine Verbindung mit dem TPS Controller 
her. Wenn der TPS Controller eingeschaltet ist und der richtige 
COM-Anschluss ausgewählt wurde, erscheint das folgende 
Dialogfeld (Abbildung 2-12).

Abb 2-12. Verbindung zwischen PC und Controller hergestellt

Außerdem erscheint auf dem Systray ein grüner Kreis, der die 
Verbindung zwischen TPS Controller und Computer anzeigt.
(Abbildung 2-13).

Abb 2-13. Verbindung hergestellt

Successful
Connection
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HINWEIS
TPS Controller speichern *.tsv-Dateien als 
Datenbankdateien; dieses Dateiformat kann von 
einem Computer jedoch nicht gespeichert 
werden. Beim Import dieser Dateien von einem 
TPS Controller an einen Computer konvertiert 
Topcon Link die Dateien vor dem Speichern 
automatisch in ein zugängliches Dateiformat 
(*.tlsv). Topcon Link muss verwendet werden, um 
die *.tlsv-Dateien in das gewünschte Format zu 
konvertieren.

VORSICHT
Verwenden Sie daher ausschließlich Topcon 
Link, um den Verlust von Daten beim Export 
von *.tsv-Dateien von einem TPS Controller 
an einen Computer zu vermeiden. 

Microsoft ActiveSync-Einstellungen

Falls der Computer über nur einen COM-Anschluss verfügt:
1. Starten Sie Microsoft ActiveSync.
2. Klicken Sie auf File->Connection Settings 

(Abbildung 2-14).

Abb 2-14. File->Connection Settings
Topcon Topcon Link-Bedienungsanleitung
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3. Klicken Sie im Dialogfeld Connection Settings auf die 
folgenden Parameter, um diese zu aktivieren 
(Abbildung 2-15):

• "Allow network (Ethernet) and Remote Access Service 
(RAS) server connection with this desktop computer"

• "Show status icon in Task bar" 

Abb 2-15. Dialogfeld "Connection Settings"

In diesem Fall fragt ActiveSync nicht nach dem COM-
Anschluss, nachdem die Verbindung zwischen TPS 
Controller und Computer getrennt wurde. Der COM-
Anschluss verbindet den Computer mit einem TPS GPS+-
Empfänger oder einer Totalstation.
Der Computer verfügt über zwei oder mehr COM-
Anschlüsse:
1. Starten Sie Microsoft ActiveSync.
2. Klicken Sie auf File->Connection Settings.
3. Nehmen Sie im Dialogfeld "Connection Settings" die 

folgenden Parametereinstellungen vor (Abbildung 2-16 
auf Seite 2-10):
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• Klicken Sie auf “Allow serial cable or infrared 
connection to this COM port”, um diese Option zu 
aktivieren.

• Wählen Sie in der Dropdown-Liste den gewünschten 
COM-Anschlus (in der Regel COM 1)

Abb 2-16. Klicken auf "Get Connected"

In diesem Fall fragt Microsoft ActiveSync nach dem COM-
Anschluss, nachdem die Verbindung zwischen Controller 
und Computer getrennt wurde. Der COM-Anschluss ist 
auschließlich für Geräte mit dem Windows CE-
Betriebssystem verfügbar.

TIP
Für Verbindungen von Computer zu Controller 
und Computer zu Empfänger/Totalstation sind 
jeweils separate COM-Anschlüsse zu verwenden.

Verwenden Sie beim Verbinden von Computer und TPS 
Controller jeweils den Schnittstellenanschluss, der im 
Dialogfeld "Connection Settings" definiert wurde.
Topcon Topcon Link-Bedienungsanleitung
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Importieren von TPS Controllerdateien

1. Klicken Sie auf das Symbol Import from Device. 
Wählen Sie im Dialogfeld "Import from Device" das 
Symbol des TPS Controllers und drücken Sie Next 
(Abbildung 2-17).

Abb 2-17. Auswahl des TPS Controllers

2. Wählen Sie im rechten Feld des nächsten "Import from 
Device"-Dialogfelds die gewünschte *.tsv-Datei aus 
(Abbildung 2-18).

Abb 2-18. Auswahl der Dateien

3. Wählen Sie im rechten Feld den Ordner, in dem Sie die 
Datei speichern wollen. Erstellen Sie falls nötig einen 
neuen Ordner.
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4. Drücken Sie Next. Die Statusleiste zeigt den Fortschritt 
des Importvorgangs an (Abbildung 2-19).

Abb 2-19. Fortschritt des Importvorgangs

Importieren von Totalstation-Dateien
Die folgenden Abschnitte beschreiben das Importieren von 
Datendateien von einer konventionellen oder robotischen 
Topcon Totalstation an einen Computer.
1. Klicken Sie im Dialogfeld Import from Device mit der 

rechten Maustaste auf das Symbol der konventionellen/
robotischen Totalstation und klicken Sie dann im Popup-
Menü auf die Option Properties (Abbildung 2-20).

Abb 2-20. Rechter Mausklick auf die Totalstation

2. Legen Sie im Dialogfeld Properties im Register General 
die folgenden Informationen fest (Abbildung 2-21) und 
klicken Sie dann auf Apply:

• Wählen Sie das Modell Ihrer Totalstation aus.
• Geben Sie ggf. weitere Informationen ein.
Topcon Topcon Link-Bedienungsanleitung



Importieren von Dateien

2-13
• Wählen Sie den seriellen Computeranschluss, über den 
die Totalstation verbunden ist.

Abb 2-21. Properties – Register "General"

3. Klicken Sie auf Advanced , um Baudrate, Datenbits, Parität, 
Stopbits und Protokoll einzurichten (Abbildung 2-22). 
Klicken Sie auf OK, um die Informationen zu übernehmen 
und das Dialogfeld zu schließen. 

Abb 2-22. Properties – Register "Advanced"

4. Befolgen Sie alle angegebenen Schritte im Feld Instruction  
des Dialogfelds Import from Device (Abbildung 2-23), um 
die Totalstation für das Importieren von Dateien 
vorzubereiten. Wählen Sie die zu importierende Datei.

Abb 2-23. Totalstation Anweisungen – Vorbereitung für Dateiimport
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5. Klicken Sie im Dialogfeld Import from Device auf die 
Schaltfläche Next. Die Statusleiste zeigt den Fortschritt des 
Importvorgangs an (Abbildung 2-24).

Abb 2-24. Fortschritt des Importvorgangs

Falls die Datendatei erfolgreich von der Totalstation an den 
Computer importiert wurde, erscheint das folgende Fenster 
(Abbildung 2-25).

Abb 2-25. Importvorgang erfolgreich

6. Klicken Sie auf OK.
7. Definieren Sie im Dialogfeld Save file imported from Total 

Station to einen Zielordner für die Datei, wählen Sie den 
Dateityp aus und geben Sie einen Dateinamen ein 
(Abbildung 2-26).

Abb 2-26. Speichern der importierten Datei

8. Klicken Sie auf Save.
Topcon Topcon Link-Bedienungsanleitung
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Falls die Totalstation ausgeschaltet ist, für die Übertragung 
nicht bereit ist oder die Kommunikationsparameter nicht richtig 
sind, wird das folgende Fenster angezeigt (Abbildung 2-27).

Abb 2-27. Fehlermeldung "Cannot Connect"

Überprüfen Sie die Anschlüsse des Gerätes und wiederholen 
Sie den Vorgang.

Exportieren von Dateien
Die folgenden Abschnitte behandeln das Exportieren von einem 
Computer:

• eine Optionenberechtigungssdatei (OAF) an einen TPS GPS+-
Empfänger;

• Koordinaten-Datendateien an eine konventionelle/robotische 
Totalstation;

• sämtliche Dateitypen an einen TPS Controller.
1. Gehen Sie zum Importieren von Dateien wie folgt vor:

• Klicken Sie auf File->Export to Device (Abbildung 2-1). 

Abb 2-28. File->Export to Device

• Drücken Sie F8.
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• Klicken Sie in der Symbolleiste auf Export 
(Abbildung 2-29).

Abb 2-29. Export To Device – Schaltfläche auf der Symbolleiste

Dieses Dialogfeld besteht aus zwei Feldern (Abbildung 2-30):
• Das obere Feld enthält die Symbole der vier Gerätetypen, 

von denen Datendateien übertragen werden können. Vorerst 
ist das jeweils zuletzt gewählte Gerät markiert.

• Das untere Feld enthält Anweisungen dazu, wie das Gerät 
zum Exportieren von Dateien bereitgestellt werden kann.

Abb 2-30. Dialogfeld "Export To Device"
Topcon Topcon Link-Bedienungsanleitung
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Exportieren von Dateien an Totalstationen
Gehen Sie wie folgt vor, um Koordinatendateien von einem 
Computer an eine aufgelistete Totalstation zu exportieren.
1. Klicken Sie im Dialogfeld Import from Device mit der 

rechten Maustaste auf das Symbol einer konventionellen/
robotischen Totalstation und klicken Sie im Popup-Menü 
auf Properties(Abbildung 2-31).

Abb 2-31. Rechter Mausklick auf eine Totalstation

2. Legen Sie im Dialogfeld Properties im Register General 
die folgenden Informationen fest (Abbildung 2-32) und 
klicken Sie dann auf Apply:

• Wählen Sie das Modell Ihrer Totalstation aus.
• Geben Sie ggf. weitere Informationen ein.
• Wählen Sie den seriellen Computeranschluss, über den 

die Totalstation verbunden ist.

Abb 2-32. Properties – Register "General"

3. Klicken Sie auf Advanced, um Baudrate, Datenbits, Parität, 
Stopbits und Protokoll einzurichten (Abbildung 2-33). 
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Klicken Sie auf OK, um die Informationen zu übernehmen 
und das Dialogfeld zu schließen. 

Abb 2-33. Properties – Register "Advanced"

4. Befolgen Sie alle angegebenen Schritte  im Feld Instruction 
des Dialogfelds Export to Device(Abbildung 2-34), um die 
Totalstation für das Exportieren von Dateien vorzubereiten.

Abb 2-34. Totalstation Anweisungen – Vorbereitung für Dateiexport

5. Klicken Sie im Dialogfeld Export to Device auf die 
Schaltfläche Next.

6. Navigieren Sie im Dialogfeld Export to Total Station from 
zur gewünschten Datei und wählen Sie diese aus 
(Abbildung 2-35).

Abb 2-35. Dialogfeld "Export To TotalStation From..."
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7. Klicken Sie auf Open. Überprüfen Sie die Totalstation 
nach der exportierten Datei (siehe dazu Handbuch der 
Totalstation).

Exportieren von OAFs an TPS-Empfänger
Topcon Positioning Systems stellt eine Optionenberechtigungs-
datei (Option Authorization File, OAF) zur Verfügung, um die 
kundenspezifischen Optionen auf einem TPS-Empfänger zu 
aktivieren. Eine OAF ermöglicht die kundenspezifische Ein-
richtung jedes Empfängers aufgrund von spezifischen Anforde-
rungen. Gehen Sie wie folgt vor, um eine OAF von einem 
Computer an einen TPS-Empfänger zu übertragen.
1. Klicken Sie im Dialogfeld Export to Device mit der rechten 

Maustaste auf das Symbol des TPS-Empfängers und 
klicken Sie dann im Popup-Menü auf die OptionProperties 
(Abbildung 2-36).

Abb 2-36. Dialogfeld "Export to Device" – Empfänger

2. Wählen Sie den Computeranschluss (seriell oder USB), an 
den der Empfänger angeschlossen ist (Abbildung 2-37).

Abb 2-37. Eigenschaften des TPS-Empfängers
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3. Klicken Sie im Dialogfeld Export to Device auf die 
Schaltfläche Next.

4. Navigieren Sie im Dialogfeld Select file to upload auf die 
OAF-Datei für den TPS-Empfänger und wählen Sie diese 
aus (Abbildung 2-38).

Abb 2-38. Dialogfeld "Select File To Upload"

5. Klicken Sie auf Open. Die Status-leiste gibt Aufschluss 
über den Fortrschritt des Übertragungsvorganges 
(Abbildung 2-39).

Abb 2-39. Fortschritt des Übertragungsvorgangs

Sobald die OAF erfolgreich vom Computer an den TPS-
Empfänger übertragen wurde, zeigt Topcon Link eine 
entsprechende Meldung an (Abbildung 2-40).

Abb 2-40. Datei erfolgreich übertragen
Topcon Topcon Link-Bedienungsanleitung
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Exportieren von Dateien an TPS Controller
Um Daten von Topcon Link an einen TPS Controller zu 
exportieren, muss zuerst Microsoft® ActiveSync™ auf dem 
Computer installiert und aufgestartet werden (siehe “Importieren 
von TPS-Controllerdateien” auf Seite 2-6). Ein grünes Symbol 
im Systray zeigt an, dass eine Verbindung zwischen dem 
Computer und dem TPS Controller hergestellt wurde.
Beim Dateiexport exportiert Topcon Link Koordinatendateien 
und TopSURV-Datenbankdateien vom Computer an einen TPS 
Controller.

• Beim Export von TopSURV-Datenbankdateien konvertiert 
Topcon Link *.tlsv-Jobformate automatisch in *.tsv-Formate.

• Beim Export von Koordinatendateien belässt Topcon Link 
die Dateien im gleichen Format.

VORSICHT
Verwenden Sie ausschließlich Topcon Link, 
um den Verlust von Daten beim Export von 
*.tlsv-Dateien von einem Computer an einen 
TPS Controller zu vermeiden.

1. Wählen Sie im Dialogfeld Export to Device einen TPS 
Controller und klicken Sie auf Next (Abbildung 2-41).

Abb 2-41. Export to Device – Controller
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2. Wählen Sie im linken Feld die zu exportierenden 
Koordinatendateien (Abbildung 2-42).

Abb 2-42. Auswahl der zu exportierenden Datei und des Zielordners

3. Wählen Sie im rechten Feld den TPS Controller, an den die 
Datei übertragen werden soll.

4. Drücken Sie Next. Die Statusleiste zeigt den Fortschritt des 
Exportvorgangs an (Abbildung 2-43).

Abb 2-43. Fortschritt des Exportvorgangs
Topcon Topcon Link-Bedienungsanleitung
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Topcon Link™ konvertiert aus folgenden Dateiformaten:
• Koordinatendateiformate:

– Topcon Totalstation (GTS-7, FC-5, GTS-210/310-10, 
GTS-210/310-12)

– Dateien mit Trennzeichen (Name,Lat,Lon,Ht,Code; 
Name,N,E,Z,Code; Name,E,N,Z,Code; Custom)

– ASCII / TSV
– TDS (CR5)

• Messdateiformate der Topcon Totalstation Rohdatenformate 
(GTS-6, GTS-7, GTS-7+, FC-5, GTS-210/310)

• TopSURV-Dateiformat (TopSURV)

• Topcon XML-Dateiformat (XML)
• GPS+-Rohmessdateiformate

– RINEX
– TPD (Topcon Positioning Data)
– TPS / JPS

• TDS-Rohdatendatei
• Geoiddatei
• Featuredatei
 7010-0522 www.topconpositioning.com
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Topcon Link konvertiert in folgende Dateiformate:
• Jegliche Koordinatendateien in:

– Andere Koordinatendateien
– Topcon XML
– TopSURV
– DXF
– GIS (Shape, LandXML, DXF)

• Jegliche Messdateien in:
– Andere Messdateien
– Beliebige Koordinatendateien
– GIS (Shape, LandXML, DXF)
– Topcon XML
– TopSURV

• TopSURV-Dateien in:
– Beliebige Koordinatendateien
– Beliebige Messdateien
– GIS (Shape, LandXML, DXF)
– Topcon XML
– GPS Vektordatei

• Topcon XML-Dateiformat in:
– Beliebige Koordinatendateien
– Beliebige Messdateien
– GIS (Shape, LandXML, DXF)
– TopSURV

• RINEX-Datei in TPD
• GPS+ TPS / JPS-Dateien und TPD-Dateien in RINEX
Topcon Topcon Link-Bedienungsanleitung
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• TSD-Rohdatendatei mit Messdatei von einer Totalstation:
– Beliebige Koordinatendateien
– Beliebige Messdateien
– GIS (Shape, LandXML, DXF)
– Topcon XML
– TopSURV

• TDS-Rohdatendatei mit RTK-Daten:
– Beliebige Koordinatendateien
– Beliebige Messdateien
– GIS (Shape, LandXML, DXF)
– Topcon XML
– GPS-Vektordatei

• Geoiddatei in Topcon Geoiddatei
• Featuredatei in TopSURV-Datei

1. Um  eine Datei von einem Format in ein anderes umzuwandeln, 
gehen Sie wie folgt vor:

• Klicken Sie auf File->Convert to File (Abbildung 3-1).

Abb 3-1. File->Convert File.

• Drücken Sie F5.
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• Klicken Sie ind der Symbolleiste auf Convert File 
(Abbildung 3-2).

Abb 3-2. Convert File – Taste auf der Symbolleiste

Das Dialogfeld Convert File   wird angezeigt (Abbildung 3-3).

Abb 3-3. Dialogfeld "Convert File"

• Im linken Feld werden die Parameter und Werte für die 
Feldoperationen der Datei aufgeführt.

• Im rechten Feld werden die nach der Umwandlung 
nötigen Parameter und Werte angezeigt.

2. Wählen Sie im linken Feld einen Dateityp aus (Abbildung 3-4).

Abb 3-4. Dateiformat-Auswahlliste
Topcon Topcon Link-Bedienungsanleitung
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3. Klicken Sie auf Browse (“...”) und wählen Sie im Dialogfeld 
Open for convert die zu konvertierende Datei aus 
(Abbildung 3-5).

Abb 3-5. Fenster "Open for Convert"

4. Klicken Sie auf Open. Der Pfad der Quelldatei wird im Feld  
Source angezeigt(Abbildung 3-6).

Abb 3-6. Fenster "Convert File" – Quelle

5. Geben Sie im rechten Feld den Zieldateinamen und Typ ein.
6. Klicken Sie auf Browse (“...”) und wählen bzw. erstellen Sie im 

Dialogfeld Select a file einen Ordner. Wählen Sie dann den 
Zieldateityp aus und geben Sie einen Zieldateinamen ein. 
Klicken Sie auf Select (Abbildung 3-7).

Abb 3-7. Auswahl einer Datei
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7. Klicken Sie auf Advanced Options, um weitere 
Umwandlungsparameter anzuzeigen. Geben Sie die 
gewünschten Informationen ein (Abbildung 3-8).

Abb 3-8. Fenster "Convert File" – Advanced Options

8. Klicken Sie im Dialogfeld Convert File auf die Option  
Convert, um den Konvertierungsprozess zu starten 
(Abbildung 3-8).

Der folgende Ablauf hängt vom Format der Quell- und Zieldateien 
ab. Für spezifische Informationen und Umwandlungsparameter 
ziehen Sie bitte die folgenden Abschnitte zu Rate.

Konvertierung von Koordinatendateien
Geben Sie bei der Konvertierung von Koordinatendateien die 
folgenden Parameter im linken/rechten Feld ein:

• Das Dateiformat (Abbildung 3-9).

Abb 3-9. Koordinatendateiformate
Topcon Topcon Link-Bedienungsanleitung
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• Aktivieren Sie die Option für  Orthometric Height, falls diese 
für die Datei benötigt wird (Abbildung 3-10).

Abb 3-10. Kontrollkästchen "Orthometric Height"

• Aktivieren Sie im linken Feld die Option Control, um die 
Koordinaten von Punkten bei der Konvertierung in eine *.tlsv-
Datei beizubehalten (Abbildung 3-11).

Abb 3-11. Kontrollkästchen "Control"

• Aktivieren Sie im rechten Feld die Option Orthometric Height, 
um die orthometrischen Höhen der konvertierten Punkte zu 
berechnen (Abbildung 3-12).

Abb 3-12. Kontrollkästchen "Orthometric Height"

• Legen Sie im rechten Feld das Geoidmodell fest:
1. Klicken Sie auf die Option Geoids List (Abbildung 3-13).

Abb 3-13. Schaltfläche "Geoids list"

2.Klicken Sie im Dialogfeld Geoids List auf die Schaltfläche 
Add (Abbildung 3-14).

Abb 3-14. Dialogfeld "Geoids List"
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3. Wählen Sie im Dialogfeld Open die gewünschte *.bin-
Datei und klicken Sie dann auf Open (Abbildung 3-15).

Abb 3-15. Fenster "Open"

4. Klicken Sie auf  Close (Abbildung 3-16).

Abb 3-16. Dialogfeld "Geoids List"

• Legen Sie im rechten Feld das Geoidmodell fest 
(Abbildung 3-17).

Abb 3-17. Auswahl des Geoidmodells
Topcon Topcon Link-Bedienungsanleitung
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ASCII/TSV und Custom Text Format-
Parameter
Legen Sie für ASCII/TSV oder Custom-Textformate Folgendes 
fest:

• Einen Projektionsnamen für den Koordinatentyp 
(Abbildung 3-18).

Abb 3-18. Projektionsliste

• oder ein Datum für den Lat,Lon,H-Koordinatentyp 
(Abbildung 3-19).

Abb 3-19. Datumliste

• Lineare Einheiten (Abbildung 3-20).

Abb 3-20. Liste der linearen Einheiten
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Name,Lat,Lon,H,Code-Formatparameter
Für Name,Lat,Lon,H,Code -Formate, legen Sie die folgenden 
Parameter fest:

• Datum (Abbildung 3-21)

Abb 3-21. Datumliste

• Lineare Einheiten (Abbildung 3-22)

Abb 3-22. Liste der linearen Einheiten

Formatparameter für andere 
Koordinatendateitypen
For GTS-7 Points, FC-5, GTS-210/310-10, GTS-210/310-12, 
Name,E,N,Z,Code oder Name,N,E,Z,Code -Formate, legen Sie 
die folgenden Parameter fest:

• Projektion (Abbildung 3-23).

Abb 3-23. Projektionsliste
Topcon Topcon Link-Bedienungsanleitung
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• Lineare Einheiten (Abbildung 3-24)

Abb 3-24. Liste der linearen Einheiten

• Geben Sie bei der Konvertierung von GTS-7 Punkt-, FC-5, 
GTS-210/310-10 und GTS-210/310-12-Dateiformaten 
(linkes Feld) dieGrid und Ground-Transformations-
parameter anhand der folgenden Vorgehensweise ein:
1. Klicken Sie auf das Kontrollkästchen Grid->Ground 

Parameters, um es zu aktivieren (Abbildung 3-25).

Abb 3-25. Aktivieren von "Grid->Ground Parameters" für Gitter-Koordinatentyp

2. Klicken Sie auf die Schaltfläche Grid to Ground 
Parameters. (Abbildung 3-26).

Abb 3-26. Schaltfläche "Grid to Ground Parameters"

3. Geben Sie die entsprechenden 
Transformationsparameter ein (Abbildung 3-27).

Abb 3-27. Dialogfeld "Grid to Ground Parameters"

4. Klicken Sie auf OK.
• Bei der Konvertierung zu GTS-7 Punkt-, FC-5 Punkt-, 

GTS-210/310-10 Punkt- und GTS-210/310-12 Punkt-Datei-
formaten (im rechten Feld), wird eine Koordinatendatei 
geschaffen, die die Grundkoordinaten enthält. 
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Befolgen Sie die Anweisungen im obenstehenden 
Abschnitt, um Feldkoordinaten in Gitterkoordinaten zu 
verwandeln.

Konvertierung von TopSURV-Dateien
Bei der Konvertierung einer TopSURV-Datei wählen Sie das 
entsprechende Dateiformat (Abbildung 3-28) und klicken Sie auf 
Convert.

Abb 3-28. Dateiformatliste

Konvertierung von Totalstation 
Rohdatendateien
Bei der Konvertierung einer Totalstation (TS) Mess-datei, sind die 
folgenden Parameter im linken/rechten Feld einzugeben.
Im linken Feld,

• das Dateiformat (Abbildung 3-29).

Abb 3-29. Dateiformatliste
Topcon Topcon Link-Bedienungsanleitung
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• der Projektionstyp (Abbildung 3-30).

Abb 3-30. Projektionsliste

• die Beziehung zwischen den Gitter- und Grundkoordinaten:
1. Klicken Sie auf das Kontrollkästchen Grid->Ground 

Parameters, um es zu aktivieren (Abbildung 3-31).

Abb 3-31. Aktivieren von Grid->Ground Parameter für Gitter-Koordinatentyp

2. Klicken Sie auf die Schaltfläche Grid to Ground 
coordinates (Abbildung 3-32).

Abb 3-32. Schaltfläche "Grid to Ground Coordinates"

3. Geben Sie im Dialogfeld Grid->Ground Parameters 
die Transformationsparameter ein (Abbildung 3-33).

Abb 3-33. Dialogfeld "Grid->Ground Parameters"
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• die Reihenfolge der Koordinaten (Abbildung 3-34).

Abb 3-34. Liste der Koordinatenreihenfolge

Im linken Feld,
• das Dateiformat (Abbildung 3-35).

Abb 3-35. Dateiformatliste

• der Projektionstyp (Abbildung 3-36).

Abb 3-36. Projektionsliste

• die Beziehung zwischen den Gitter- und Feldkoordinaten:
1. Klicken Sie auf das Kontrollkästchen Grid->Ground 

Parameters, um es zu aktivieren (Abbildung 3-31).

Abb 3-37. Aktivieren von Grid->Ground-Parameter für Gitter-Koordinatentyp
Topcon Topcon Link-Bedienungsanleitung
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2. Klicken Sie auf die Schaltfläche Grid to Ground 
coordinates (Abbildung 3-38).

Abb 3-38. Schaltfläche "Grid to Ground Coordinates"

3. Geben Sie im DialogfeldGrid->Ground Parameters 
die Transformationsparameter ein (Abbildung 3-39).

Abb 3-39. Dialogfeld "Grid->Ground Parameters"

• Lineare Einheiten (Abbildung 3-40).

Abb 3-40. Liste der linearen Einheiten

• Winkeleinheiten (Abbildung 3-41).

Abb 3-41. Liste der Winkeleinheiten

• die Koordinatenreihenfolge (Abbildung 3-42).

Abb 3-42. Liste der Koordinatenreihenfolge

Konvertierung von Topcon XML-Dateien
Geben Sie bei der Konvertierung von Topcon XML-Dateien die 
folgenden Parameter im linken Feld ein:
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• Wählen Sie das Dateiformat aus (Abbildung 3-43).

Abb 3-43. Dateiformatliste

• Wählen Sie den Koordinatentyp (Abbildung 3-44).

Abb 3-44. Koordinatentypliste

Bei Ground- oder Grid-Koordinatentyp legen Sie 
Projektion, lineare Einheit und Winkeleinheit fest 
(Abbildung 3-45).

Abb 3-45. Listen "Projection, Linear Unit, Angular Unit"
Topcon Topcon Link-Bedienungsanleitung



Konvertierung von Topcon XML-Dateien

3-17
Bei Lat,Lon,H-Koordintentyp legen Sie Datum, lineare 
Einheit und Winkeleinheit fest (Abbildung 3-46).

Abb 3-46. Listen "Datum, Linear Unit, and Angular Unit"

• Falls Feldkoordinatentyp ausgwählt wurden, geben Sie die 
Beziehung zwischen Gitter- und Feldkoordinaten ein:

1. Klicken Sie auf das Kontrollkästchen Grid->Ground 
Parameters, um es zu aktivieren (Abbildung 3-47).

Abb 3-47. Aktivieren von Grid->Ground Parameter für Gitterkoordinatentyp

2. Klicken Sie auf die Schaltfläche Grid to Ground 
coordinates (Abbildung 3-48).

Abb 3-48. Schaltfläche "Grid to Ground Coordinates"
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3. Geben Sie im Dialogfeld Grid->Ground Parameters 
die Transformations-parameter ein (Abbildung 3-49).

Abb 3-49. Dialogfeld "Grid->Ground Parameters"

Konvertierung von LandXML-Dateien
Geben Sie bei der Konvertierung von LandXML-Dateien die 
folgenden Parameter im linken Feld ein:

• Wählen Sie das Dateiformat aus (Abbildung 3-50).

Abb 3-50. Dateiformatliste

• Wählen Sie den Koordinatentyp (Abbildung 3-51).

Abb 3-51. Koordinatentypliste
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Bei Ground- oder Grid -Koordinatentyp legen Sie 
Projektion, lineare Einheit und Winkeleinheit fest 
(Abbildung 3-52).

Abb 3-52. Listen "Projection, Linear Unit, Angular Unit"

Bei Lat,Lon,H--Koordintentyp legen Sie Datum, lineare 
und Winkeleinheit fest (Abbildung 3-53).

Abb 3-53. Listen "Datum, Linear Unit, and Angular Unit"

• Falls Feldkoordinatentyp ausgwählt wurden (Abbildung 3-54 
auf Seite 3-20), geben Sie die Beziehung zwischen Gitter- und 
Feldkoordinaten ein:

1. Klicken Sie auf das Kontrollkästchen Grid->Ground 
Parameters, um es zu aktivieren (Abbildung 3-54 auf 
Seite 3-20).
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Abb 3-54. Aktivieren von Grid->Ground Parameter für Gitterkoordinatentyp

2. Klicken Sie auf die Schaltfläche Grid to Ground 
coordinates (Abbildung 3-55).

Abb 3-55. Schaltfläche "Grid to Ground Coordinates"

3. Geben Sie im Dialogfeld Grid->Ground Parameters 
die Transformations-parameter ein (Abbildung 3-56).

Abb 3-56. Dialogfeld "Grid->Ground Parameters"

Konvertieren von GPS+
Rohdatendateien
Beim Konvertieren einer GPS+-Rohdatendatei (TPS, JNS, RINEX, 
TPD) wählen Sie  im Feld From das richtige Dateiformat 
(Abbildung 3-57).

Abb 3-57. Dateiformatliste
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Konvertierung in GIS-Dateien
Geben Sie bei der Konvertierung von GIS-Dateien im rechten Feld 
die folgenden Parameter ein:

• Wählen Sie das Dateiformat aus (Abbildung 3-58).

Abb 3-58. Dateiformatliste

• Wählen Sie den Koordinatentyp (Abbildung 3-59).

Abb 3-59. Koordinatenypliste

Bei Ground- und Grid-Koordinatentyp legen Sie 
Projektion, lineare Einheit und Winkeleinheit fest 
(Abbildung 3-60).

Abb 3-60. Listen "Projection and Linear Unit"
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Bei Lat,Lon,H-Koordintentyp legen Sie Datum und lineare 
Einheiten fest (Abbildung 3-61).

Abb 3-61. Listen "Datum and Linear Unit"

• Bei Feldkoordinatentyp legen Sie die Beziehung zwischen 
Feld- und Gitterkoordinaten fest. Siehe Schritte 1 bis 3 für 
weitere Hinweise Seite 3-19 zu diesem Verfahren.

• Aktivieren Sie die Option  Orthometric Height, um die 
orthometischen Höhen für die konvertierten Punkte zu 
errechnen (Abbildung 3-62).

Abb 3-62. Orhtometrische Höhe

• Legen Sie das Geoidmodell fest:
1. Klicken Sie auf Geoids List (Abbildung 3-63).

Abb 3-63. Schaltfläche "Geoids list"
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2. Klicken Sie im Dialgofeld Geoids List auf die 
Schaltfläche Add (Abbildung 3-64).

Abb 3-64. Dialofeld "Geoids List"

3. Wählen Sie die gewünschte *.bin-Datei im Dialofeld 
Open und klicken Sie dann auf Open (Abbildung 3-65).

Abb 3-65. Fenster "Open"

4. Klicken Sie auf Close (Abbildung 3-66).

Abb 3-66. Dialogfeld "Geoids List"

• Wählen Sie ein  Geoidmodell (Abbildung 3-67).

Abb 3-67. Auswahl des Geoidmodells
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Konvertieren in TPD GPS+
Rohdatendateien
Beim Konvertieren in eine TPD GPS+-Rohdatendatei wählen Sie 
im Feld To das richtige Dateiformat (Abbildung 3-68).

Abb 3-68. Dateiformatliste

Konvertieren in RINEX GPS+
Rohdatendateien
Beim Konvertieren in eine RINEX GPS+-Rohdatendatei legen Sie 
im Feld To die folgenden Parameter fest:

• Wählen Sie das Dateiformat aus (Abbildung 3-69).

Abb 3-69. Dateiformatliste

• Klicken Sie auf GLONASS, um GLONASS 
Rohdatenmessungen/Ephemerisdaten ein- bzw. auszuschließen 
(Abbildung 3-70 auf Seite 3-25).
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• Klicken Sie auf L1 und/oder L2, um L1 oder L2 
Rohdatenmessungen ein- bzw. auszuschließen (Abbildung 3-70). 
Sind beide Felder deaktiviert (nicht angekreuzt), erstellt Topcon 
Link lediglich eine Navigationsdatei (*.0?o).

Abb 3-70. RINEX Advanced Options – Aktiviert

Konvertieren von TDS-
Rohdatendateien
Geben Sie bei der Konvertierung von TDS-Messdateien im linken 
Feld die folgenden Parameter ein:

• Das Dateiformat (Abbildung 3-71).

Abb 3-71. TDS-Rohdatenformate

• Projektionstyp (Abbildung 3-72).

Abb 3-72. Projektionsliste
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• Lineare Einheiten (Abbildung 3-73).

Abb 3-73. Liste der linearen Einheiten

• Winkel-einheiten (Abbildung 3-74).

Abb 3-74. Liste der Winkeleinheiten

Konvertierung von Geoiddateien
Wählen Sie beim Konvertieren einer Geoiddatei die entsprechende 
Datei im Feld From (Abbildung 3-75).

Abb 3-75. Globales Geoidformat
Topcon Topcon Link-Bedienungsanleitung
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Konvertierung von Topcon Geoiddateien
Geoiddateien können zur Verwendung mit Topcon Tools und 
TopSURV in das Topcon Geoiddateiformat umgewandelt werden.
Setzen Sie beim Konvertieren einer Topcon Geoiddatei im Feld To 
die folgenden Parameter fest:

• Wählen Sie das Dateiformat aus (Abbildung 3-76).

Abb 3-76. Geoiddateiformat

• Bestimmen Sie die Positionen der Punkte, die die Verwendung 
dieses Geoidmodels einschränken (Abbildung 3-77).

Abb 3-77. Punktlimiten

HINWEIS: Geben Sie geografische Breite und Länge in dem in 
Abbildung 3-78 gezeigten Format ein.

Abb 3-78. Breiten- und Längenformat

TIP
Breitengrade sind auf der Nordhalbkugel positiv. 
Längengrade sind auf der östlichen Halbkugel 
positiv.
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Konvertierung von Featuredateien
Wählen Sie beim Konvertieren einer Featuredatei im Feld From das 
richtige Dateiformat aus (Abbildung 3-79).

Abb 3-79. Featuredateiformat

Konverieren in eine GPS-Vektordatei
Wählen Sie beim Konvertieren in eine GPS-Vektordatei im oberen 
Feld das Dateiformat aus (Abbildung 3-80).

Abb 3-80. GPS-Vektordateiformat

Siehe Anhang C für weitere Hinweise.
Topcon Topcon Link-Bedienungsanleitung



Kapitel 4

P/N
Verwaltung von Dateien
4-1
Dieses Kapitel behandelt das Öffnen, die Ansicht und Bearbeitung 
von Dateien in Topcon Link™.

Öffnen von Dateien
Topcon Link kann die folgenden Dateiformate und -typen  öffnen:

• Koordinatendateiformate:
– Topcon Totalstation (GTS-7, FC-5, GTS-210/310-10, 

GTS-210/310-12)

–Dateien mit Trennzeichen  (Name,Lat,Lon,Ht,Code; 
Name,N,E,Z,Code; Name,E,N,Z,Code; Custom)

–TSV ASCII

– DS (CR5)
• Messdateiformate von Topcon Totalstationen

(GTS-6, GTS-7, GTS-7+, FC-5, GTS-210/310)
• TopSURV-Dateiformat (TopSURV-Dateien).
• Feature datei

1. Gehen Sie wie folgt vor, um eine Datei zu öffnen:
• Klicken Sie auf File->Open File (Abbildung 4-1).

Abb 4-1. File->Open File...

• Drücken Sie Ctrl+O.
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• Klicken Sie in der Symbolleiste auf Open (Abbildung 4-2).

Abb 4-2. Open – Schaltfläche auf der Symbolleiste

Das Dialogfeld Open erscheint (Abbildung 4-3).

Abb 4-3. Dialogfeld "Open"

2. Um ein Dateiformate auszuwählen, verwenden Sie die die 
Dropdown-Liste Format name und gehen Sie wie folgt vor:

• Wählen Sie das Dateiformat, falls es Ihnen bekannt ist 
(Abbildung 4-4).

Abb 4-4. Dateiformat
Topcon Topcon Link-Bedienungsanleitung
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• Wählen Sie den Dateityp, falls dieser Ihnen bekannt, das 
Dateiformat jedoch unbekannt ist (Abbildung 4-5).

Abb 4-5. Dateityp

• Falls Ihnen Dateifromat und -typ nicht bekannt sind, 
wählen die Option "All Files" (Abbildung 4-6). In diesem 
Fall ermittelt die Topcon Link -Software Dateityp und -
format selbst.

Abb 4-6. Option "All Files"

3. Klicken Sie auf Open. Die Datei wird in Topcon Link geöffnet.
Falls ein inkompatibler Dateiname und Dateiformat gewählt 
wurden, erscheint eine Fehlermeldung (Abbildung 4-7).

Abb 4-7. Fehlermeldung bei unbekanntem Dateiformat

Wählen Sie den korrekten Dateinamen bzw.-format und 
wiederholen Sie den Vorgang.
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Einrichten von benutzerdefinierten 
Dateiformaten
Um eine Datei mit beliebigem Koordinatenformat zu öffnen, 
erstellen Sie ein benutzerdefiniertes Format im Dialogfeld 
"Open" und speichern Sie dieses. 
1. Wählen Sie im Dialogfeld  Open in der Dropdown-Liste 

Format name die Option "Custom Text Format" und geben 
Sie im Feld Dateiname einen Namen ein (Abbildung 4-8). 
Klicken Sie auf Open.

Abb 4-8. Custom Textformat

2. Geben Sie im Dialogfeld Custom format properties die 
Dateiparameter ein (Abbildung 4-9 auf Seite 4-5).

• Delimiters – unterteilendes Satzzeichen; entweder 
Komma, Leerschlag, Tab oder Strichpunkt.

• Coordinate system – Gitter-, Feld- oder BLH-
Koordinatensystem.

• Koordiniert Reihenfolge, Codes und Kommentare. 
Wählen Sie den gewünschten Eintrag aus (Namen, 
Koordinaten, Codes, Kommentare) und gehen Sie dann 
wie folgt vor:
–Verwenden Sie die rechte Pfeiltaste, um Einträge vom 
linken ins rechte Feld zu verschieben. Die Reihenfolge 
der Namen muss im rechten Feld mit der in der 
geöffneten Datei übereinstimmen.
–Verwenden Sie die linke Pfeiltaste, um Einträge vom 
rechten Feld wieder zurück ins linke Feld zu verschieben.
–Verwenden Sie die nach unten und nach oben 
zeigenden Pfeiltasten, um die Reihenfolge der Namen 
im rechten Feld zu verändern.

• Formatname und Dateiendung.
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Abb 4-9. Dialogfeld "Custom Format Properties"

3. Klicken Sie auf OK. Topcon Link verhält sich wie folgt:
• Speichert die benutzerdefinierte Formatbeschreibung 

im Ordner "Formats".
• Speichert den Formatnamen in die Liste der 

Koordinatendateiformate (Abbildung 4-10).

Abb 4-10. In der Dateiformatliste gespeicherter Formatname

• Versuchen Sie, die gewünschte Datei zu öffnen.

HINWEIS
Falls das neue Koordinatendateiformat nicht 
speziell benannt wurde, verwendet Topcon Link 
den Standarddateinamen "UnName*.*". 
In diesem Falle wird das neue Dateiformat beim 
Herunterfahren des Systems gelöscht.
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Ansicht von Dateien
Nachdem eine Datei geöffnet bzw. von einem externen Gerät 
übertragen wurde, erscheint eine Datentabelle im Arbeitsbereich 
der Topcon Link-Software.

Datentabelle der Koordinatendatei
Koordinatendateien zeigen Informationen in einer Datentabelle 
an (Abbildung 4-11).

Abb 4-11. Koordinatendatei

Das Register Points verfügt  (Abbildung 4-11) über die 
folgenden Spalten:

• Name – den Namen des Punktes
• Northing – die gemessene Hochwert-Koordinate des 

Punktes sowie den Koordinatentyp
• Easting – die gemessene Rechtswert-Koordinate des 

Punktes sowie den Koordinatentyp
• Elevation – die Höhe des Punktes
• Note – jegliche auf den Punkt bezogene Bemerkungen
• Code – jegliche auf den Punkt bezogene Codes
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Tabelle 4-1 zeigt die Symbole auf, die Topcon Link zur 
Darstellung der Informationen in der Datentabelle verwendet.

Rohdatendateitabelle für Totalstationen
Totalstation (TS) Rohdatendateien zeigen Informationen in der 
Datentabelle in zwei Registern auf (Abbildung 4-12).

Abb 4-12. Totalstation Rohdatendatei

Das Register Points (Abbildung 4-12) verfügt über die 
folgenden Spalten für gemessene (nicht berechnete) Punkte:

• Name – den Namen des Punktes
• Northing – die gemessene Hochwert-Koordinate des 

Punktes sowie den Koordinatentyp

Tabelle 4-1. Koordinatendatei-Symbole

Stelle Symbole Beschreibung

Koordinatendatei-Symbole

Register "Points"
Unbekannter Punkt

Punkt mit festen Koordinaten
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• Easting – die gemessene Rechtswert-Koordinate des 
Punktes sowie den Koordinatentyp

• Elevation – die Höhe des Punktes
• Note – jegliche auf den Punkt bezogene Bemerkungen
• Code – jegliche auf den Punkt bezogene Codes

Das linke Feld des Registers TS Obs  (Abbildung 4-13 auf 
Seite 4-8) verfügt über die folgenden Spalten für Punkte mit 
bekannten Koordinaten:

• # – die Anzahl Punkte
• Point Name – den Namen des Punktes
• Instrument Height – die Höhe des Instruments in der 

gewählten Einheit (ft, m)

Abb 4-13. Register "TS Obs"– Linkes Feld

Das rechte Feld des Registers TS Obs (Abbildung 4-14) verfügt 
über die folgenden Spalten für Punkte mit unbekannten 
Koordinaten, die anhand des Punktes im linken Feld berechnet 
wurden:

• # – Punktnummer
• Point From – der Ursprung des Vektors
• Point To – der Endpunkt des Vektors
• Reflector Height – die Höhe des Reflektors
• Azimut, horizontaler Kreis, Zenitwinkel, Neigungsstrecke 

– Winkel- und Linearmessungen in der gewählten Einheit
    (ft, m)
Topcon Topcon Link-Bedienungsanleitung
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• Code – jegliche auf den Punkt bezogene Codes
• Type – Art des Punktes (BS, SS, FS oder BKB)

Abb 4-14. Register "TS Obs"– Rechtes Feld

Tabelle 4-2 zeigt die Symbole auf, die Topcon Link zur 
Darstellung der Informationen in der Datentabelle verwendet.

Tabelle 4-2. Totalstation Rohdatendateisymbole

Stelle Symbole Beschreibung

TS Rohdatenmessung-Dateisymbole

Register "Points"
TS Station

TS Punkt

Register "TS 
Obs"– Linkes Feld

TS Station

Register "TS 
Obs"– Rechtes 
Feld

Vorausmessung

Seitenmessung

Rückmessung

Rückmessung Richtungspunkt

TS Rückwärtseinschnitt
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TopSURV-Dateidatentabelle
TopSURV-Rohdatendateien zeigen Informationen in der 
Datentabelle in vier Registern an (Abbildung 4-15).

Abb 4-15. TopSURV-Rohdatendatei

Das Register Points (Abbildung 4-15) verfügt über die 
folgenden Spalten:

• Name – den Namen des Punktes
• Northing – die gemessene Hochwert-Koordinate des 

Punktes sowie den Koordinatentyp
• Easting – die gemessene Rechtswert-Koordinate des 

Punktes sowie den Koordinatentyp
• Elevation – die Höhe des Punktes
• Note – jegliche auf den Punkt bezogene Bemerkungen
• Code – jegliche auf den Punkt bezogene Codes

Das Register GPS Occupations  (Abbildung 4-16 auf Seite 4-11) 
verfügt über die folgenden Spalten für individuell gemessene 
Punkte:

• Point Name – den Namen des Punktes
• Antenna Type – den am Punkt verwendeten Antennentyp
• Antenna Height – die Höhe der Antenne in der gewählten 

Einheit (ft, m)
Topcon Topcon Link-Bedienungsanleitung
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• Antenna Height Method – die zur Messung der 
Antennenhöhe verwendete Methode (vertikal oder schräg)

• Start Time – die Startzeit der Messung
• Duration – die Messdauer

Abb 4-16. Register "GPS Occupations"

Das linke Feld des Registers TS Obs (Abbildung 4-17 auf 
Seite 4-12) verfügt über die folgenden Spalten für Punkte mit 
bekannten Koordinaten:

• # – die Anzahl Punkte
• Point Name – den Namen des Punktes
• Instrument Height – die Höhe des Instruments in der 

gewählten Einheit (ft, m)
Das rechte Feld des Registers TS Obs (Abbildung 4-17 auf 
Seite 4-12) verfügt über die folgenden Spalten für Punkte mit 
unbekannten Koordinaten, die anhand des Punktes im linken 
Feld berechnet wurden::

• # – Punktnummer
• Point From – der Ursprung des Vektors
• Point To – der Endpunkt des Vektors
• Reflector Height – die Höhe des Reflektors
• Azimut, horizontaler Kreis, Zenitwinkel, Neigungsstrecke 

– Winkel- und Linearmessungen in der gewählten Einheit
    (ft, m)

• Code – jegliche auf den Punkt bezogene Codes
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• Type – Art des Punktes (BS, SS, FS oder BKB)

Abb 4-17. Register "TS Obs"

Das Register GPS Obs (Abbildung 4-18 auf Seite 4-13) verfügt 
über die folgenden Spalten für Grundlinienmessungen von der 
Basisstation zum Punkt der Rover-Station:

• Point From – der Startpunkt der Basislinienmessung
• Point To – der Endpunkt der Basislinienmessung
• Start Time – Datum und Uhrzeit des Messbeginns
• Duration – die Messdauer
• Notes – jegliche Bemerkungen zur Basislinienmessung
• Horizontal Precisions, Vertical Precisions – zeigt die 

horizontale und vertikale Genauigkeit der Messung an
• dn, de, du – zeigt die Tafeldifferenz der Messung an
• Method – zeigt die Messmethode an (RTK Topo, RTK Auto)
• Solution type – zeigt die für die Messung verwendete 

Lösungsart an:
–Failed: Messung konnte nicht verarbeitet werden
–Code Diff: Code-Unterschiedsmessung
–Phase Diff Float: Pufferphasen-Unterschiedsmessung
–Phase Diff Fixed: Fixphasen-Unterschiedsmessung
Topcon Topcon Link-Bedienungsanleitung
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Abb 4-18. Register "GPS Obs"

Das linke Feld des Registers Codes (Abbildung 4-19) zeigt eine 
Tabelle mit verfügbaren *.tslv-Datencodes an.
Das rechte Feld des Registers Codes(Abbildung 4-19) enthält 
die folgenden Spalten:

• Name – einen eindeutigen Codenamen
• Default value – einen numerischen Standardwert für den 

Code
• Type – die Art des Codes (numerisch, Text, oder List)

Abb 4-19. Register "Codes"
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Tabelle 4-3 zeigt die Symbole auf, die Topcon Link zur 
Darstellung der Informationen in der Datentabelle verwendet.

Tabelle 4-3. TopSURV-Dateisymbole

Stelle Symbole Beschreibung

TopSURV TS-Dateisymbole

Register "Points"

TS Station

TS Punkt

TS Visierpunkt

Manuell eingegebene Punktkoordinaten

Anhand von COGO berechnete 
Punktkoordinaten

Designpunkt

Aussteck-Punkt

Punkt mit festen Koordinaten

Register "TS Obs"– 
Linkes Feld

TS Station

Register "TS Obs"– 
Rechtes Feld

Vorausmessung

Seitenmessung

Rückmessung

Rückmessung Richtungspunkt

TS Rückwärtseinschnitt

TS MLM-Beobachtung
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TopSURV TS-Dateisymbole

Register "Points"

Basisstation

Angepeilter Festpunkt

Angepeilter beweglicher Punkt

Manuell eingegebene Punktkoordinaten

Anhand von COGO berechnete 
Punktkoordinaten

Designpunkt

Aussteck-Punkt

Punkt mit festen Koordinaten

Register "GPS 
Occupations"

Basisstation-Besetzung

Statische Besetzung

Bewegliche Besetzung

Register "GPS 
Obs"

Basislinie von Basisstation zum Festpunkt

Basislinie von Basisstation zum 
beweglichen Punkt

Tabelle 4-3. TopSURV-Dateisymbole

Stelle Symbole Beschreibung
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Ansicht von Dateieigenschaften
Um die Eigenschaften einer Datei anzuzeigen, klicken Sie auf 
File->File properties (Abbildung 4-20).

Abb 4-20. File->File Properties

• Coordinate files – zeigt den Pfad zur geöffneten Datei 
sowie Dateiformat an (Abbildung 4-21).

Abb 4-21. Eigenschaften der Koordinatendatei

• TopSURV files – zeigt den Dateinamen, den Pfad zur 
geöffneten Datei, Dateiformat, Jobnamen sowie Name des 
Vermessungsingenieurs an (Abbildung 4-22).

Abb 4-22. Eigenschaften der TopSURV-Datei
Topcon Topcon Link-Bedienungsanleitung
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• Totalstation Rohdatendateien
– zeigt Namen und Formatdaten im Register "General" 

an (Abbildung 4-21); 
– zeig Datum, Instrument, Job, Name des 

Vermessungsingenieurs und Bemerkungen im 
Register "Session" an (Abbildung 4-23).

Abb 4-23. Eigenschaften von TS Rohdatendateien – Session

Bearbeiten von Dateien
Nachdem eine Datei improtiert und/oder konvertiert wurde, kann 
sie mit praktischen Schritten verwendet, verwaltet und bearbeitet 
werden. Durch Speichern von Dateien kann Datenverlust 
vermieden werden und Dateien können gemeinsam benutzt und 
exportiert werden.

Speichern von Dateien
Bevor eine bearbeitete Datei (*.*) zum ersten Mal gespeichert wird, 
estellt Topcon Link im aktuellen Ordner vorerst eine Kopie der 
ursprünglichen Datei (*.*.initial). Diese Datei bleibt unverändert. 
Sämtliche Änderungen werden in der *.*-Datei gespeichert.

Speichern von Änderungen an der aktuellen 
Datei und deren Format

Gehen Sie zum Speichern von Änderungen wie folgt vor:
• Klicken Sie auf File->Save File.
• Drücken Sie Ctrl+S.
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• Klicken Sie in der Symbolleiste auf das Symbol Save.
• Schließen Sie das aktuelle Fenster und bestätigen Sie 

im Dialogfeld Save Changes?  mit Yes .

Speichern von Änderungen in einem anderen 
Format

HINWEIS
Topcon Link kann veränderte Informationen nicht 
abspeichern, falls die Datei nicht über die 
entsprechenden Felder verfügt. If Note or Code 
information changed for GTS-210/310-10, GTS-
210/310-12, FC-5 format files or user-defined 
format files without Note or Code columns, 
Topcon Link will display the following dialog box 
(Abbildung 4-24). Speichern Sie die Datei in 
einem anderen Format.

Abb 4-24. Speichern in einem anderen Format?

• Klicken Sie auf No oder Cancel, um ohne Speichern 
fortzufahren.

• Klicken Sie auf Yes, um die Datei zu speichern.
1. Um die Datei in einem anderen Format zu speichern, 

klicken Sie auf Yes.
2. Gehen Sie im Dialogfeld Save as wie folgt vor:

–Wählen Sie im Feld Format File ein 
benutzerdefiniertes Feld, dass die Spalten "Note" und 
"Code" enthält  (Abbildung 4-25).

Abb 4-25. Formatname
Topcon Topcon Link-Bedienungsanleitung
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–Definieren Sie ein neues Format, das die Spalten Note 
und Code enthält. Wählen Sie im Fenster Format File 
die Option Custom Text Format und klicken Sie auf 
Open. Definieren Sie dann ein neues Format, das die 
Spalten Note und Code enthält. Siehe “Einrichten von 
benutzerdefinierten Dateiformaten” auf Seite 4-4 für 
weitere Hinweise. 

3. Geben Sie den Namen und Speicherort der neuen Datei 
ein.

4. Klicken Sie auf Save.

Speichern von Änderungen in einer anderen 
Datei

Gehen Sie zum Abspeichern einer Datei unter einem 
anderen Namen wie folgt vor:
1. Klicken Sie auf  File->Save As.
2. Wählen bzw. erstellen Sie einen Zielordner und geben 

Sie im Dialogfeld Save As einen neuen Namen ein 
(Abbildung 4-26).

Abb 4-26. Dialogfeld "Save As"

3. Klicken Sie auf Save.
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Bearbeiten von Koordinatendateien
In Koordinatendateien (Abbildung 4-27) können die folgenden 
Angaben bearbeitet werden:

• Punktname
• Punktkoordinate
• Bemerkung
• Code
• Reihenfolge der Koordinatenpunkte

Abb 4-27. Koordinatendatei

Um die Informationen in einer Koordinatendatei zu bearbeiten, 
klicken Sie mit der rechten Maustaste auf einen Punkteintrag. 
Das Popup-Menü der Koordinatendatei erscheint 
(Abbildung 4-28).

Abb 4-28. Popup-Menü der Koordinatendatei

• Cut – schneidet die Informationen aus
• Copy – kopiert die Informationen
• Delete – löscht die Informationen
• Properties – zeigt das Dialogfeld mit den Eigenschaften an.
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Bearbeiten von Namen und Bemerkungen

Gehen Sie wie folgt vor, um Punktnamen und 
Bemerkungen in einer Koordinatendatei zu bearbeiten:
1. Klicken Sie mit der rechten Maustaste auf einen Punkt 

und klicken Sie dann im Popup-Menü auf  Properties.
2. Klicken Sie im Dialogfeld Properties auf das Register 

General (Abbildung 4-29).

Abb 4-29. Koordinateneigenschaften – Register "General"

3. Füllen Sie die Felder Name und Note wie gewünscht 
aus.

4. Klicken Sie auf OK, um die Informationen zu 
übernehmen und das Dialogfeld zu schließen. Klicken 
Sie auf Apply, um die Informationen zu übernehmen 
und mit dem Bearbeiten des Punktes weiterzufahren.
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Bearbeiten von Koordinateneigenschaften

Gehen Sie wie folgt vor, um die Koordinateneigenschaften 
in einer Koordinatendatei zu bearbeiten:
1. Klicken Sie mit der rechten Maustaste auf einen Punkt 

und klicken Sie dann im Popup-Menü auf  Properties.
2. Klicken Sie im Dialogfeld Properties auf das Register 

Coordinates (Abbildung 4-30).

Abb 4-30. Koordinateneigenschaften – Register "Coordinates"

3. Füllen Sie die Felder Northing, Easting, und Elevation 
wie gewünscht aus.

4. Klicken Sie auf OK, um die Informationen zu 
übernehmen und das Dialogfeld zu schließen. Klicken 
Sie auf Apply, um die Informationen zu übernehmen 
und mit dem Bearbeiten des Punktes weiterzufahren.

5. Um die Reihenfolge der Koordinatenpunkte zu ändern, 
klicken Sie auf File->Job Configuration. 

6. Klicken Sie im Dialogfeld Job Configuration zuerst 
auf  Display und anschließend auf das Register 
Points(Abbildung 4-31).

Abb 4-31. Jobkonfiguration – Register "Points"

7. Passen Sie die Reihenfolge der Koordinaten wie 
gewünscht an. Klicken Sie auf OK.
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Bearbeiten von CAD-Eigenschaften
Um die CAD-Eigenschaften eines Punktes in einer 
Koordinatendatei anzupassen,
1. klicken Sie mit der rechten Maustaste auf einen Punkt 

und klicken Sie dann im Popup-Menü auf  Properties.
2. klicken Sie im Dialogfeld Properties auf das Register 

CAD(Abbildung 4-30).

Abb 4-32. Koordinateneigenschaften – Register "CAD"

3. Wählen bzw. bearbeiten Sie die Codes wie gewünscht.
4. Klicken Sie auf OK, um die Informationen zu 

übernehmen und das Dialogfeld zu schließen. Klicken 
Sie auf Apply, um die Informationen zu übernehmen 
und mit dem Bearbeiten des Punktes weiterzufahren.

Bearbeiten von Totalstation Rohdatendateien

In Rohdatendateien einer Totalstation (TS) (Abbildung 4-33 auf 
Seite 4-24) können die folgenden Angaben bearbeitet werden:

• Punktname und Punktnummer
• Instrumentenhöhe
• Punkt zu und Punktbemerkungen
• Reflektorenhöhe und Azimut
• Offsets
• CAD-Informationen
• String-Eigenschaften
• Beobachtungsanzeige
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Abb 4-33. Totalstation Rohdatendatei

Um die TS Punktdateiinformationen im linken Feld zu bearbeiten, 
klicken Sie mit der rechten Maustaste auf einen Punkteintrag, so 
dass das entsprechende Popup-Menü erscheint (Abbildung 4-34).

Abb 4-34. TS Punktdatei – Popup-Menü im linken Feld

Um die TS Punktdateiinformationen im rechten Feld zu 
bearbeiten, klicken Sie mit der rechten Maustaste auf einen 
Punkteintrag, so dass das entsprechende Popup-Menü erscheint 
(Abbildung 4-35).

Abb 4-35. TS Punktdatei – Popup-Menü im rechten Feld

• Cut – schneidet die Informationen aus
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• Copy – kopiert die Informationen
• Delete – löscht die Informationen
• Properties – zeigt das Dialogfeld mit den Eigenschaften an.
• Options – zeigt das Dialogfeld mit den Optionen an.

TIP
Klicken Sie die Titelleiste einer Spalte an, um die 
Daten in aufsteigender bzw. absteigender 
Reihenfolge anzuzeigen.

Bearbeiten von Namen, Instrumentenhöhe und 
Nummereigenschaften

Um Namen, Instrumentenhöhe und Nummereigenschaften 
eines Punktes in einer TS Rohdatendatei zu bearbeiten,
1. Klicken Sie mit der rechten Maustaste auf einen Punkt 

im linken Feld und klicken Sie dann im Popup-Menü 
auf Properties.

2. Bearbeiten Sie im Dialogfeld Properties den 
Punktnamen, die Instrumentenhöhe und Punktnummer 
wie gewünscht (Abbildung 4-36).

Abb 4-36. Eigenschaften

3. Klicken Sie auf OK, um die Informationen zu 
übernehmen und das Dialogfeld zu schließen. Klicken 
Sie auf Apply, um die Informationen zu übernehmen 
und mit dem Bearbeiten des Punktes weiterzufahren.
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Bearbeiten der Point To- und Notes-Eigenschaften

Um die Point to- und Notes-Eigenschaften eines Punktes in 
einer TS Rohdatendatei zu bearbeiten,
1. Klicken Sie mit der rechten Maustaste auf einen Punkt 

im rechten Feld und klicken Sie dann im Popup-Menü 
auf Properties.

2. Klicken sie im Dialogfeld Properties auf das Register 
General(Abbildung 4-37).

Abb 4-37. TS Properties – Register "General"

3. Bearbeiten Sie die Felder Point To, Note und Code wie 
gewünscht.

4. Klicken Sie auf OK, um die Informationen zu 
übernehmen und das Dialogfeld zu schließen. Klicken 
Sie auf Apply, um die Informationen zu übernehmen 
und mit dem Bearbeiten des Punktes weiterzufahren.

Bearbeiten von Reflektorhöhe und Azimut-
Eigenschaften

Gehen Sie wie folgt vor, um die Reflektorhöhe und 
Azimut-Eigenschaften eines Punktes in einer TS 
Rohdatendatei zu bearbeiten:
1. Klicken Sie mit der rechten Maustaste auf einen Punkt 

im rechten Feld und klicken Sie dann im Popup-Menü 
auf Properties.
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2. Klicken Sie im Dialogfeld Properties auf das Register 
Observation(Abbildung 4-38).

Abb 4-38. TS Properties – Register "Observation"

3. Bearbeiten Sie die Felder Reflector Height und Azimuth 
wie gewünscht.

4. Klicken Sie auf OK, um die Informationen zu 
übernehmen und das Dialogfeld zu schließen. Klicken 
Sie auf Apply, um die Informationen zu übernehmen 
und mit dem Bearbeiten des Punktes weiterzufahren.

Bearbeiten von Offset-Eigenschaften

Gehen Sie wie folgt vor, um die Offset-Eigenschaften eines 
Punktes in einer TS Rohdatendatei zu bearbeiten:
1. Klicken Sie mit der rechten Maustaste auf einen Punkt 

im rechten Feld und klicken Sie dann im Popup-Menü 
auf Properties.

2. Klicken Sie im Dialogfeld Properties auf das Register 
Offset(Abbildung 4-39).

Abb 4-39. TS Properties – Register "Offset"
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3. Bearbeiten Sie das Feld Offset wie gewünscht.
4. Klicken Sie auf OK, um die Informationen zu 

übernehmen und das Dialogfeld zu schließen. Klicken 
Sie auf Apply, um die Informationen zu übernehmen 
und mit dem Bearbeiten des Punktes weiterzufahren.

Bearbeiten von String-Eigenschaften

Gehen Sie wie folgt vor, um die String-Eigenschaften eines 
Punktes in einer TS Rohdatendatei zu bearbeiten (nur verfüg-
bar, wenn Display String and Control Code aktiviert ist; siehe 
“Bearbeiten der Punktcode-Beschreibung” auf Seite 4-30):
1. Klicken Sie mit der rechten Maustaste auf einen Punkt 

im rechten Feld und klicken Sie dann im Popup-Menü 
auf Properties.

2. Klicken Sie im Dialogfeld Properties auf das Register 
String(Abbildung 4-40).

Abb 4-40. TS Properties – Register "CAD"

3. Bearbeiten Sie die Felder String und Control Code wie 
gewünscht.

4. Klicken Sie auf OK, um die Informationen zu 
übernehmen und das Dialogfeld zu schließen. Klicken 
Sie auf Apply, um die Informationen zu übernehmen 
und mit dem Bearbeiten des Punktes weiterzufahren.
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Bearbeiten von Beobachtungsanzeigen-
Einstellungen

Gehen Sie wie folgt vor, um die Beobachtungsanzeigen-
Einstellungen eines Punktes in einer TS Rohdatendatei zu 
bearbeiten:
1. Klicken Sie mit der rechten Maustaste auf einen Punkt 

im rechten Feld und klicken Sie dann im Popup-Menü 
auf Options.

2. Wählen Sie im Dialogfeld Options auf dem Register 
Display, wie die Beobachtungsdaten auf der 
Totalstation angezeigt werden sollen (Abbildung 4-41).

Abb 4-41. TS Options

3. Klicken Sie auf das Kontrollkästchen Show offsets, um 
es zu aktivieren und alle Ausgleichswerte in der 
Datentabelle anzuzeigen.

4. Klicken Sie auf OK, um die Informationen zu 
übernehmen und das Dialogfeld zu schließen. Klicken 
Sie auf Apply, um die Informationen zu übernehmen 
und mit dem Bearbeiten des Punktes weiterzufahren.
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Bearbeiten der Punktcode-Beschreibung

Gehen Sie wie folgt vor, um den Buchstaben-/Zahlencode 
für die Punktbeschreibung in einer TS Rohdatendatei zu 
bearbeiten:
1. Klicken Sie auf File->Job Configuration 

(Abbildung 4-42).

Abb 4-42. File->Job Configuration

2. Klicken Sie im Dialogfeld Job Configuration zuerst 
auf das Register Display und anschließend auf 
Strings(Abbildung 4-43).

Abb 4-43. Job Configuration – Register "Strings"

3. Klicken Sie auf die Option Display String and Control 
Code. Spalten für String- und Kontrollcodes werden im 
rechten Feld des Registers TS Obs hinzugefügt. 
Die Register CAD und String werden neu im 
Dialogfeld Properties angezeigt.

4. Klicken Sie auf OK.
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Bearbeiten von mehreren Punkten

Gehen Sie wie folgt vor, um die Instrumentenhöhe, 
Reflektorhöhe, Bemerkungen, den Punktnamen oder die 
Messungen mehrerer Punkte in einem der beiden Felder zu 
bearbeiten:
1. Drücken Sie die Shift-Taste und wählen Sie dann 

mehrere Reihen an. (Abbildung 4-44).

Abb 4-44. Anwählen und Bearbeiten mehrerer Datenreihen

2. Geben Sie die neuen Informationen für die gewählte 
Reihe ein (Abbildung 4-44).

3. Drücken Sie Enter, um die bearbeiteten Informationen 
auf die ganze Reihe anzuwenden.

Bearbeiten von TopSURV-Dateien
In TopSURV-Dateien (Abbildung 4-45 auf Seite 4-32) önnen 
die folgenden Angaben bearbeitet werden:

• Punktparameter:
–Name und Bemerkung, Punktkoordinaten und Codes
–Koordinatentyp und Reihenfolge

• GPS Besetzungsparameter:
–Name
–Antennentyp und -höhe, Höhenmessungsmethode
–Offsets

• TS Beobachtungsparameter: Name; Antennenhöhe
P/N 7010-0522 www.topconpositioning.com



Verwaltung von Dateien

4-32
• GPS Besetzungsparameter:
–Für GPS Rohdatendateien: Vektornotizen
–Für TS Rohdatendateien: Instrumentenname, Job ID 
   und Lokation, Vermessungsingenieur und Notizen;
    Temperatur- und Druckdaten

Abb 4-45. TopSURV-Sampledatei

Um die TopSURV-Dateiinformationen zu bearbeiten, klicken 
Sie mit der rechten Maustaste auf einen Punkteintrag, so dass 
das entsprechende Popup-Menü erscheint (Abbildung 4-35).

Abb 4-46. TS Punktdatei – Popup-Menü im rechten Feld

• Cut – schneidet die Informationen aus
• Copy – kopiert die Informationen
• Delete – löscht die Informationen
• Properties – zeigt das Dialogfeld mit den Eigenschaften an.
• Options – (nur in bestimmten Registern verfügbar) zeigt 

das Dialogfeld "Options" an
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Bearbeiten von Punktnamen- und 
Notizeigenschaften

Basisstation, statische und kinematische Punktkoordinaten 
von GPS Lösungen werden im Register Points angezeigt. 
Punkte, die im RTK-Modus berechnet wurden, werden in 
dem Koordinatensystem/Projektion angezeigt, die beim 
Erstellen des Jobs in TopSURV festgelegt wurden.
1. Um Punktnamen, Notizen und Codes zu bearbeiten, 

klicken Sie mit der rechten Maustaste auf einen Punkt 
und klicken Sie im Popup-Menü auf Properties.

2. Klicken Sie im Dialogfeld Properties auf das Register 
General(Abbildung 4-47).

Abb 4-47. Point Properties – Register "General"

3. Bearbeiten Sie die Felder Name, Note und Code wie 
gewünscht.

4. Klicken Sie auf OK, um die Informationen zu 
übernehmen und das Dialogfeld zu schließen. Klicken 
Sie auf Apply, um die Informationen zu übernehmen 
und mit dem Bearbeiten des Punktes weiterzufahren.

Bearbeiten von Punktkoordinaten

1. Um die Punktkoordinaten zu bearbeiten, klicken Sie 
mit der rechten Maustaste auf einen Punkt und klicken 
Sie im Popup-Menü auf Properties.

2. Klicken Sie im Dialogfeld Properties auf das Register 
Coordinates(Abbildung 4-48 auf Seite 4-34).
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Abb 4-48. Point Properties – Register "Coordinates"

3. Bearbeiten Sie die Felder Latitude, Longitude und Ell. 
Height wie gewünscht.

4. Klicken Sie auf OK, um die Informationen zu 
übernehmen und das Dialogfeld zu schließen. Klicken 
Sie auf Apply, um die Informationen zu übernehmen 
und mit dem Bearbeiten des Punktes weiterzufahren.

Hinzufügen eines neuen Punktcodes

1. Um einen neuen Punktcode hinzuzufügen, klicken Sie 
mit der rechten Maustaste auf einen Punkt und wählen 
Sie im Popup-Menü die Option Properties.

2. Klicken Sie im Dialogfeld Properties auf das Register 
CAD(Abbildung 4-47).

Abb 4-49. Point Properties – Register "CAD"
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3. Klicken Sie mit der rechten Maustaste auf das Feld 
Name und wählen Sie im Popup-Menü dann die Option 
New Code(Abbildung 4-50).

Abb 4-50. Popup-Menü "Code"

4. Geben Sie den Namen des neuen Codes ein und 
drücken Sie dann Enter.

5. Klicken Sie auf OK, um die Informationen zu 
übernehmen und das Dialogfeld zu schließen. Klicken 
Sie auf Apply, um die Informationen zu übernehmen 
und mit dem Bearbeiten des Punktes weiterzufahren.

Bearbeiten eines GPS Besetzungs-
Punktnamens

1. Klicken Sie auf das Register GPS Occupations.
2. Um den Punktnamen zu bearbeiten, klicken Sie mit der 

rechten Maustaste darauf und wählen Sie im Popup-
Menü die Option Properties.

3. Klicken Sie im Dialogfeld Properties auf das Register 
General(Abbildung 4-51).

Abb 4-51. Point Properties – Register "General"
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4. Bearbeiten Sie das Feld Name wie gewünscht.
5. Klicken Sie auf OK, um die Informationen zu 

übernehmen und das Dialogfeld zu schließen. Klicken 
Sie auf Apply, um die Informationen zu übernehmen 
und mit dem Bearbeiten des Punktes weiterzufahren.

Bearbeiten von GPS Besetzungs-
Antennenparametern

1. Klicken Sie auf das Register GPS Occupations.
2. Um die Antennenparameter zu bearbeiten, klicken Sie 

mit der rechten Maustaste auf den Punkt und wählen 
Sie im Popup-Menü die OptionProperties.

3. Klicken Sie im Dialogfeld Properties auf das Register 
Antenna(Abbildung 4-51).

Abb 4-52. Point Properties – Register "Antenna"

4. Bearbeiten Sie die Felder Type, Height und Method wie 
gewünscht.

5. Klicken Sie auf OK, um die Informationen zu 
übernehmen und das Dialogfeld zu schließen. Klicken 
Sie auf Apply, um die Informationen zu übernehmen 
und mit dem Bearbeiten des Punktes weiterzufahren.

Bearbeiten von GPS Besetzungs-Offsets

1. Klicken Sie auf das Register GPS Occupations.
2. Um die Punktoffsets zu bearbeiten, klicken Sie mit der 

rechten Maustaste auf den Punkt und wählen Sie im 
Popup-Menü die Option Properties.
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3. Klicken Sie im Dialogfeld Properties auf das Register 
Offset(Abbildung 4-51).

Abb 4-53. Point Properties – Register "Offset"

4. Bearbeiten Sie das Feld Offset wie gewünscht.
5. Klicken Sie auf OK, um die Informationen zu 

übernehmen und das Dialogfeld zu schließen. Klicken 
Sie auf Apply, um die Informationen zu übernehmen 
und mit dem Bearbeiten des Punktes weiterzufahren.

Bearbeiten von TS Obs-Parametern

1. Klicken Sie auf das Register TS Obs.
2. Um die Eigenschaften im Register TS Obs zu 

bearbeiten, siehe “Bearbeiten von Totalstation 
Rohdatendateien” auf Seite 4-23.

Bearbeiten von GPS Obs-Punktnotizen

1. Klicken Sie auf das Register GPS Obs.
2. Um die Punktnotizen zu bearbeiten, klicken Sie mit der 

rechten Maustaste auf den Punkt und wählen Sie im 
Popup-Menü die Option Properties.
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3. Klicken Sie im Dialogfed Properties auf das Register 
General(Abbildung 4-51).

Abb 4-54. Point Properties – Register "General"

4. Bearbeiten Sie das Feld Note wie gewünscht.
5. Klicken Sie auf OK, um die Informationen zu 

übernehmen und das Dialogfeld zu schließen. Klicken 
Sie auf Apply, um die Informationen zu übernehmen 
und mit dem Bearbeiten des Punktes weiterzufahren.

Ansicht von GPS Obs-Punktbeobachtungen

1. Klicken Sie auf das Register GPS Obs.
2. Um die Punktbeobachtungen anzuzeigen, klicken Sie 

mit der rechten Maustaste auf den Punkt und wählen 
Sie im Popup-Menü die Option Properties.

3. Klicken Sie im Dialogfeld Properties auf das Register 
Observation(Abbildung 4-51).

Abb 4-55. Point Properties – Register "Oberservation"
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4. Klicken Sie auf OK, um das Dialogfeld zu schließen.

Bearbeiten der GPS Beoabachtungsanzeige

1. Klicken Sie auf das Register GPS Obs.
2. Um die GPS Beobachtungsanzeige zu bearbeiten, 

klicken Sie mit der rechten Maustaste auf den Punkt 
und wählen Sie im Popup-Menü die Option Options.

3. Wählen Sie im Dialogfeld Options die gewünschte 
Koordinaten-Basislinie (Abbildung 4-51).

Abb 4-56. Point Properties – Register "General"

4. Klicken Sie auf OK, um die Informationen zu 
übernehmen und das Dialogfeld zu schließen. Klicken 
Sie auf Apply, um die Informationen zu übernehmen 
und mit dem Bearbeiten des Punktes weiterzufahren.

Berabeiten von TopSURV-Dateicodes

1. Klicken Sie auf das Register Codes.
2. Um die Codeattribute zu bearbeiten, klicken Sie mit der 

rechten Maustaste darauf und wählen Sie im Popup-
Menü die Option New Attribute und wählen Sie dann 
die gewünschten Attribute (Abbildung 4-57).

Abb 4-57. Auswahl von Codeattributen
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3. Geben Sie im Dialogfed "Attributes" die 
entsprechenden Parameter für die Codeattribute ein 
(Abbildung 4-58, Abbildung 4-59, und 
Abbildung 4-60). Klicken Sie auf OK. 

Abb 4-58. Berabeiten von Code-Nummerattributen

Abb 4-59. Bearbeiten von Code-Textattributen

Abb 4-60. Bearbeiten von Code-Menüattributen
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TIP
Doppelklicken Sie später zum Bearbeiten auf 
das Attribut.

4. Gehen Sie wie folgt vor, um den Codenamen zu 
bearbeiten:

• Doppelklicken Sie auf den Codenamen, geben Sie den 
neuen Namen ein und drücken Sie dann Enter.

• Klicken Sie mit der rechten Maustaste auf den 
Codenamen und wählen Sie im Popup-Menü die 
Option Properties. Bearbeiten Sie den Codenamen und 
klicken Sie auf OK (Abbildung 4-61).

Abb 4-61. Bearbeiten von Codenamen
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Hinweise:
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Kapitel 5

P/N
Verwendung von Dateien
5-1
Dieses Kapitel behandelt die mit Topcon Link™ verfügbaren 
Dateifunktionen.

Berechnen von Koordinaten
Gehen Sie wie folgt vor, um Punktkoordinaten mit Hilfe von 
Rohdateninformationen zu berechnen:
1. Öffnen Sie eine Rohdatendatei.
2. Gehen Sie wie folgt vor:

• Klicken Sie auf Process->Compute Coordinates 
(Abbildung 5-1).

Abb 5-1. Process->Compute Coordinates

• Klicken Sie in der Symbolleiste auf Compute Coordinates  
(Abbildung 5-2).

Abb 5-2. Compute Coordinates – Schaltfläche auf der Symbolleiste

HINWEIS
Falls für keine der Punkte Koordinaten bekannt 
sind, verwendet Topcon Link einen Punkt mit 
(0, 0, 0) Koordinaten als Ausgangspunkt.
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Topcon Link berechnet dann die Punktekoordinaten und fügt Sie dem 
Fenster der Rohdatendatei der Totalstation hinzu (Abbildung 5-3).

Abb 5-3. Rohdatendatei

Ausgleichung eines Polygonzuges
Dieses Verfahren kombiniert die Berechnung von 
Punktekoordinaten mit der Netzwerkausgleichung.
Netzwerkausgleichungsmethoden werden wie folgt klassifiziert: 

• Bedingte Ausgleichung – beinhaltet Abgleich des inneren 
Winkels, Azimuts, Kompassregel (Bowditch-Regel), 
Transitregel und Crandall-Methode.

• Strenge Ausgleichung – beinhaltet die Methode der kleinsten 
Quadrate.

Traditionelle bedingte Ausgleichungsmethoden wurden entwickelt, 
um den herrschenden Bedingungen in bestimmten Kombinationen 
von Winkel- und Liniengenauigkeit in den Beobachtungen 
Rechnung zu tragen.
In diesem Sinne sind die folgenden Kombinationen gebräuchlich:

• Die Winkel- bzw. Richtungsgenauigkeit ist jeweils höher in 
entsprechenden Beobachtungen von linearen Strecken.
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• Die Winkel- bzw. Richtungsgenauigkeit entspricht im Wesent-
lichen dem entsprechenden Wert für Genauigkeit von Strecken.

• Streckengenauigkeit ist höher als Winkel- und 
Richtungsgenauigkeit.

Einstellen des Ausgleichungstyps
1. Um eine Netzwerkausgleichungsart auszuwählen, klicken 

Sie auf Process-> Prozesseigenschaften.
2. Wählen Sie im Dialogfeld Process properties das Register 

Compute Coordinates und wählen Sie einen der folgenden 
Ausgleichungsarten (Abbildung 5-4): 

• None – Keine, setzt a priori Werte voraus
• Least Squares – Kleinste Quadrate: setzt a priori Werte 

voraus; siehe “Methode der kleinsten Quadrate” auf 
Seite 5-5 für weitere Informationen

• Compass Rule – Kompassregel, siehe “Kompassregel” 
auf Seite 5-5 für weitere Informationen

• Transit – siehe “Transitregel” auf Seite 5-6 für weitere 
Informationen

• Crandall – siehe “Crandall-Methode” auf Seite 5-6 für 
weitere Informationen

• Angle Balance – Winkelausgleich, siehe 
“Ausgleichmethode des inneren Winkels” auf Seite 5-7 
für weitere Informationen

Abb 5-4. Register "Process Properties – Compute Coordinates"
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3. Wählen Sie einen Azimut-Ausgleichsparameter 
(Abbildung 5-4). Siehe “Azimutausgleichmethode” auf 
Seite 5-7 für weitere Hinweise.

4. Wählen Sie für die Ausgleichungsarten Keine oder 
Kleinste Quadrate die a priori Werte des Fehlers von 
Linear- oder Winkelmessungen (Abbildung 5-5). 
Die "Keine"-Methode wird lediglich bei der Lösung eines 
Rückwärtseinschnitts verwendet.

Abb 5-5. Festsetzen von a priori Werten für die Methode der kleinsten Quadrate

5. Klicken Sie auf  OK.

Einstellen des Refraktionskoeffizienten
Um den vertikalen Winkel der Erdkrümmung und die 
Lichtbrechung in der Atmosphäre zu korrigieren, wählen Sie 
das Register TS-Computation im Dialogfeld Process properties 
und legen Sie den entsprechenden Refraktionskoeffizienten fest 
(Abbildung 5-6).

Abb 5-6. Register "Process Properties – TS-Computation"
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Methode der kleinsten Quadrate
Die Methode der kleinsten Quadrate führt zur strengsten 
Ausgleichung:

• erlauben Variationen in der Beobachtungsgenauigkeit,
• minimieren zufällige Abweichungen in Beobachtungen,
• bieten die besten Schätzungen für Positionen aller 

Polygonzugstationen und
• liefern auf die Genauigkeit von Ausgleichungs-

beobachtungen und Positionen bezogene Statistiken. 
Diese Methode stellt einen größeren Berechnungsaufwand dar 
als die bedingte Ausgeichung.

Kompassregel
Die Kompassregel wurde für die zweite Kombination von 
Genauigkeit und Beobachtungen entwickelt und zeigt sich in 
der Regel strenger, wenn die Bedingung der Äquivalenz 
zwischen der Winkelgenauigkeit und der Streckengenauigkeit 
strikte durchgesetzt wird.
Bei der Kompassregel  werden Ausgleichungen in beiden 
Breiten und Abweichungen in Proportion zur Länge von 
Strecken angewendet. Mit anderen Worten, je länger eine Linie, 
desto größer ihre Breite und Abweichungsausgleichungen (und 
umgekehrt). Dies wird in den folgenden Formeln illustriert:

Diese Methode findet bei geschlossenen Polygonzügen oder 
Polygonzügen zwischen zwei bekannten Punkten Anwendung.

AdjustmentInLatitudeAB
LatitudeMisclosure

------------------------------------------------------------------ LengthOfAB
PerimeterOfTraverse
---------------------------------------------------------=

AdjustmentInDepartureAB
DepartureMisclosure

------------------------------------------------------------------------ LengthOfAB
PerimeterOfTraverse
---------------------------------------------------------=
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Transitregel
Die Transitregel wurde für die erste Kombination von 
Genauigkeit und Beoabachtungen entwickelt.
Bei der Transitregel werden Ausgleichungen an Breiten in 
Proportion zu ihrer jeweiligen Länge gemacht. Daraus folgt, 
dass je länger eine Breite, desto größer ist auch ihre 
Ausgleichung (und umgekehrt). Gleichermaßen werden 
Ausgleichungen an entsprechenden Abweichungen 
proportional zur jeweiligen Länge vorgenommen. 
Ausgleichungen können aufgrund der folgenden Formeln 
berechnet werden:

Diese Methode findet bei geschlossenen Polygonzügen oder 
Polygonzügen zwischen zwei bekannten Punkten Anwendung.

Crandall-Methode
Die Crandall-Methode ist ein eher kompliziertes Verfahren, 
das strenger ist als die Kompass- oder Transitregel und 
wesentlich mehr Berechnungen benötigt.
In der Crandall-Methode der Ausgleichung von Polygonzügen 
wird der Winkelfehler über alle gemessenen Winkel 
gleichmäßig verteilt. Die angepassten Winkel werden sodann 
gleich gehalten und sämtliche verbleibenden Korrekturen 
werden durch ein Verfahren der kleinsten Quadrate 
gleichmäßig auf die Linearmessungen verteilt. Die Crandall-
Methode eignet sich zur Ausgleichung von Polygonzügen, in 
denen die Linearmessungen größere Zufallsfehler enthalten als 
die Winkelmessungen. 

AdjustmentInLatitudeAB
LatitudeMisclosure

------------------------------------------------------------------ LatitudeOfAB
AbsoluteSumOfLatitudes
-------------------------------------------------------------------=

AdjustmentInDepartureAB
DepartureMisclosure

------------------------------------------------------------------------ DepartureOfAB
AbsoluteSumOfDepartures
------------------------------------------------------------------------=
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Dank dieser Winkelausgleichung funktioniert diese Methode 
nur für geschlossene Polygonzüge oder Polygonzüge, in denen 
die Scheitelkreise an Anfangs- und Endpunkt bekannt sind und 
die in denen die Anfangs- und Endpunkte für die Zuweisung 
von Streckenkorrekturen bekannt sind.

Ausgleichmethode des inneren Winkels
Die Ausgleichsmethode des inneren Winkels Die Summe aller 
Innenwinkel in einem geschlossenen Polygonzug (Loop) sollte 
(n-2)* 180 Grad betragen. Die Abweichung sollte gleichmäßig 
über die inneren Winkel verteilt werden. Dies trifft nur für 
geschlossene Polygonzüge (Loops) zu.

Azimutausgleichmethode
Die Azimut-Ausgleichmethode. Nachdem Ihnen die 
Scheitelkreise am Anfang und Endpunkt des Polygonzuges 
bekannt sind, berechnen Sie den Scheitelkreis-Abschlussfehler 
und verteilen Sie ihn gleichmäßig auf alle Richtungsmessungen. 
Findet bei offenen Polygonzügen Anwendung.

Benutzerdefinierte Parameter
1. Um die Informationsansicht der geöffneten Datei anzuzeigen, 

klicken Sie auf File->Job Configuration (Abbildung 5-7).

Abb 5-7. File->Job Configuration
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2. Klicken Sie im Dialogfeld Job Configuration auf die Option 
Display. (Abbildung 5-8).

Abb 5-8. Job Configuration – Klicken auf "Display"

3. Passen Sie die folgenden Parameter an: 

• Im Register Precisions (Abbildung 5-9) kann die Anzahl 
Dezimalstellen angepasst werden.

Abb 5-9. Register "Precisions"

• Im Register Points  (Abbildung 5-10) werden 
Koordinatentyp und Koordinatenreihenfolge festgelegt.

Abb 5-10. Register "Points"
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• Im Register Angles  (Abbildung 5-11) kann die Darstellung 
von Winkeln angepasst werden.

Abb 5-11. Register "Angles"

• Das Register Strings  (Abbildung 5-12) enthält das Feld 
zum ein-/ausschalten des alphanumerischen Codes für 
Messpunkte auf dem Bildschirm.

Abb 5-12. Register "Strings"

• Das Register GPS Obs  (Abbildung 5-13) definiert die 
Darstellung der Basislinienkoordinaten.

Abb 5-13. Register "GPS Obs"
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• Das Register TS Obs  (Abbildung 5-14) definiert die 
Darstellung der Totalstation-Messungen.

Abb 5-14. Register "TS Obs"

4. Um verfügbare Geoiddateien anzuzeigen, hinzuzufügen oder 
zu entfernen, klicken Sie im Dialogfeld "Job Configuration" 
auf die Option "Coordinate Systems"(Abbildung 5-15).

Abb 5-15. Job Configuration – Coordinate Systems

5. Um die Zeitspanne zwischen automatischen Speichervorgän-
gen beim Bearbeiten einer Datei zu verändern, klicken Sie im 
Dialogfeld Job Configuration auf die OptionSave und geben 
Sie die gewünschte Zeitspanne ein (Abbildung 5-16).

Abb 5-16. Job Configuration – Klicken auf "Save" und Anpassen des 
Speicherintervalls
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• Topcon Link erstellt nach Ablauf der festgelegten 
Zeistpanne automatisch eine Sicherungskopie der 
bearbeiteten Datei.
Sobald die Datei abgespeichert wird, löscht Topcon Link 
die Sicherungsdatei automatisch.

• Die Standardeinstellung ab Werk liegt bei 10 Minuten; 
die kleinste Zeitspanne liegt bei 1 Minute. Um die 
automatische Speicherfunktion zu deaktivieren, geben Sie 
im Feld AutoSave Interval "0" ein. 

• Wird Topcon Link nach einem ungültigen Herunteren 
aufgestartet und eine bearbeitete Datei konnte nicht 
gespeichert werden, öffnet Topcon Link die Sicherungskopie 
der Datei und benennt diese “Recovered” (wiederhergestellt).

6. Um die Anpassungsart zu ändern, klicken Sie auf Process 
properties (Abbildung 5-17)

Abb 5-17. Job Configuration – Einstellen der Prozesseigenschaften

Drucken von Dateien
Gehen Sie wie folgt vor, um eine Koordinatendatei, TS 
Rohdatendatei oder TopSURV-Datei zu drucken:
1. Öffnen Sie die entsprechende Datei.
2. Klicken Sie auf File->Print Setup und legen Sie die Printer 

Properties-, Paper Size-, und Orientation-Parameter fest.
3. Klicken Sie im Dateifenster auf das gewünschte Register oder 

das linke/rechte Feld.
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4. Klicken Sie auf File->Print Preview. Überprüfen Sie die 
Dateidarstellung (Abbildung 5-18). Wiederholen Sie ggf. 
Schritte 2 und 3.

Abb 5-18. Print Preview – Register "Points", TopSURV-Datei

5. Klicken Sie auf das Menü File->Print  und anschließen auf 
OK.
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A-1
Topcon Positioning Systems stellt eine Optionenberechtigungsdatei 
(Option Authorization File, OAF) für die Aktivierung 
kundenspezifischer Optionen zur Verfügung. 
Eine Optionenberechtigungsdatei erlaubt es Kunden, den 
Empfänger gemäß Ihren speziellen Anforderungen zu 
konfigurieren und lediglich in die Optionen zu investieren, die sie 
tatsächlich benötigen.
In der Regel werden alle Empfänger mit temporären OAFs 
geliefert, die für einen beschränkten Zeitraum benutzt werden 
können. Beim Kauf eines Empängers aktiviert eine neue OAF die 
gewünschten erworbenen Optionen permanent. 
Die Empfängeroptionen werden durch Löschen des NVRAM oder 
eine Rücksetzung des Geräts nicht beeinträchtigt.
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A-2
Die OAF aktiviert die folgenden Funktiontstypen. Für eine 
ausführliche Liste der erhältlichen Optionen und detaillierte 
Informationen besuchen Sie bitte die TPS Website 
(www.topcongps.com/tech/index) oder wenden Sie sich an Ihren 
TPS Händler.

• Signaltyp (Standard L1, 
optional L2)

• Speicher (Standard 0 Mb; 
optional 1 MB bis 96 MB)

• Aktualisierungsrate 
(Standard 1 Hz; optional 5, 
10 oder 20 Hz)

• RTK bei 1 Hz, 5 Hz, 10 Hz 
und 20 Hz

• RTCM/CMR Input/Output
• Ereignismarker

• Co-Op Tracking
• Erweiterte 

Mehrwegreduktion
• Wide Area Augmentation 

System (WAAS)
• Receiver Autonomous 

Integrity Monitoring 
(RAIM)

• 1 PPS (Pulse-Per-Second; 
ein Taktsignal)
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Kabel/COM Anschlüsse
B-1
Serielles Schnittstellenkabel
Serielle Schnittstellenkabel verbinden die Totalstation (TS) mit 
einem IBM-kompatiblen Computer.

• F-4 Kabel (GTS – D-sub 9-polig). Tabelle B-1 erklärt die 
Polanschlüsse für TS und Computer (PC).

• F-3 Kabel (GTS – D-sub 25-polig). Tabelle B-2 erklärt die 
Polanschlüsse für TS und Computer (PC).

Tabelle B-1. F-4 Kabel

(GTS)    (PC)

GND (1) (5) GND

N.C. (2)

TXD (3) (3) RXD

RXD (4) (2) TXD

(RTS) (5) (8) CTS

N.C. (6) (6) DSR

Tabelle B-2. F-3 Kabel

(GTS)    (PC)

GND (1) (1) FG

N.C. (2) (7) SG
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Paralleles Schnittstellenkabel
Das parallele Schnittstellenkabel verbindet die TS mit einem 
Centronics-Drucker. 
B-2 Kabel (GTS Parallel – Centronics 1/F 38-polig). Tabelle B-3 
erklärt die Polanschlüsse für Totalstation und Drucker.

TXD (3) (3) RXD

RXD (4) (2) TXD

(RTS) (5) (5) CTS

N.C. (6) (6) DSR

Tabelle B-3. F-4 Kabel

(GTS)    (Drucker)

STROB (1) (1) STROB

BUSY (2) (11) INPUT-BUSY

D0 (3) (2) DATA1

D1 (4) (3) DATA2

D2 (5) (4) DATA3

D3 (6) (5) DATA4

D4 (7) (6) DATA5

D5 (8) (7) DATA6

D6 (9) (8) DATA7

D7 (10) (9) DATA8

GND (11) (14) GND

N.C. (12) (16) GND

Tabelle B-2. F-3 Kabel (Continued)

(GTS)    (PC)
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B-3
Serielle C-RS232C Steckerdefinition
Das RS232 Kabel verbindet den GNSS TPS-Empfänger 
(Anschlüsse A und D) mit einem Computer. Abbildung B-1 zeigt 
die Anordnung der Pole für den Stecker des Empfängers.

Abb B-1. RS232C Empfängerstecker

Tabelle B-4 gibt Informationen zu RS232 Anschlüssen.

Die RS232 Steckertypen sind versiegelte Anschlüsse, 7-polig W.W. 
FISCHER, INC, p/n DBEU 102 A056. 

Tabelle B-4. RS232 Steckerspezifikationen

Nummer: Signalname Dir Informationen

1 Power_OUT P Power Output (I<0.2 A)

2 GND - Betriebserde

3 CTS E Sendebereit

4 RTS A Sendeforderung

5 RXD E Datenempfang

6 TXD A Datenübertragung

7 Nicht in Betrieb
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B-4
Tabelle B-5 gibt Informationen zum Anschluss von Empfänger und 
Kabel.

Totalstation COM: 
Anschlusseinstellungen
Die folgenden RS-232-C Schnittstellenoptionen können im 
Anwendungsprogramm der Serie GTS-600 eingerichtet werden.
Baudrate: 1200  /  2400  /  4800  /  9600  /  19200 Baud
Parität: KEINE /  UNGERADE  /  GERADE
Datenbits: 7  /  8
Stopbits: 1  /  2
Protokoll: ACK – NACK (Nur im FC-5 Format übertragbar) 

EINWEG

Die folgenden RS-232-C Schnittstellenoptionen können im 
Anwendungsprogramm der Serie GTS-700 eingerichtet werden.

Baudrate: 300  /  1200  /  2400  /  4800  /  9600  /  19200
Parität: KEINE /  UNGERADE  /  GERADE
Datenbits: 7  /  8
Stopbits: 0  /  1  /  2         

Tabelle B-5. RS232 Anschlussinformationen

TPS-Empfänger DB9 Buchse

1 -

2 5

3 7

4 8

5 3

6 2

7 1
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B-5
Protokoll: XON-XOFF
ACK – NACK (nur im FC-5 Format übertragbar)

Die folgenden RS-232-C Schnittstellenoptionen können im 
Anwendungsprogramm der Serie GTS-800A eingerichtet werden.

Baudrate: 1200  /  2400  /  4800  /  9600 Baud
Parität: KEINE /  UNGERADE  /  GERADE
Datenbits: 7  /  8
Stopbits: 1  /  2

Datenformat: ASCII
Signalkontrolle:RTS. Hi / Low

Die folgenden RS-232-C Schnittstellenoptionen können im 
Anwendungsprogramm der Serie GTS-2000 eingerichtet werden:

Baudrate: 300  /  600 / 1200  /  2400  /  4800  /  9600 Baud
Parität: KEINE /  UNGERADE  /  GERADE
Datenbits: 7  /  8
Stopbits: 1  /  2
Protokoll: ACK – NACK (Nur im FC-5 Format übertragbar) 

EINWEG

Die folgenden RS-232-C Schnittstellenoptionen können im 
Anwendungsprogramm der Serie AP-L1A eingerichtet werden:
Bitformat: Auswahl von ElementenInhalten

D8 S1 KEINE 8bit, stop 1, KEINE 
D8 S2 KEINE 8bit, stop 2, KEINE
D7 S1 KEINE 7bit, stop 1, KEINE
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B-6
D7 S2 KEINE 7bit, stop 2, KEINE
D8 S1 GERADE 8bit, stop 1, GERADE 
D8 S2 GERADE 8bit, stop 2, GERADE 
D7 S1 GERADE 7bit, stop 1, GERADE 
D7 S2 GERADE 7bit, stop 2, GERADE 
D8 S1 UNGERADE 8bit, stop 1, UNGERADE 
D8 S2 UNGERADE 8bit, stop 2, UNGERADE
D7 S1 UNGERADE 7bit, stop 1, UNGERADE
D7 S2 UNGERADE 7bit, stop 2, UNGERADE

Übertragungsgeschwindigkeit (in Baud):COM1 COM2
38400
19200
9600 9600
4800 4800

2400 2400

1200 1200

Terminate: EXT, ETX+CR, ETX+CRLF

Protokoll: (nur für COM2)

Auswahlelement Inhalt

SERIELL Basierend auf RS-232C 

(3-Liniensystem)

MODEMBasierend auf RS-232C.
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B-7
COM-Anschlusseinstellungen für 
GNSS-Empfänger
Die folgenden RS-232-C Schnittstellenoptionen sind Standard-
Kommunikationseinstellungen für das Anwendungsprogramm des 
GNSS-Empfängers.
Anschlusseingabemodus: CMD für GRIL oder Command für 

PC-CDU; der Anschluss ist im 
Kommandozustand. In diesem Modus 
erkennt der Anschluss die vom Benutzer 
gesendeten Befehle.

Hardware-Handshake: AUS
Baudrate des seriellen 
Anschlusses: 115200 Baud
Stopbits: 1
Parität: K (keine Parität)
Datenbits: 8 
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B-8
Hinweise:
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Appendix C

P/N
Sample-Dateiformate
C-1
Koordinatendateiformate
Topcon Link kann verschiedene Datentypen senden, empfangen 
und konvertieren. Die ASCII-Formate werden nachfolgend 
aufgeführt. Diese Sample-Dateien werden in den Screenshots in der 
Topcon Link-Bedienungsanleitung verwendet.

GTS-6 Punkt-Koordinatenformat 
GTS-6 Koordinateneingabe und -ausgabe weisen das gleiche 
Format auf.
Name, X(Rechtswert), Y(Hochwert), Z(Höhe)
_+1 _ x+00000009939_ y+00000013376_ z+00000001119
_+10 _ x+00000018482_ y+00000015981_ z+00000000022
_+11 _ x+00000015360_ y+00000016995_ z+00000000018
_+1113 _ x+00000013121_ y+00000012355_ z-00000001882
_+1114 _ x+00000010307_ y+00000013914_ z+00000000721
_+12 _ x+00000013520_ y+00000013371_ z+00000001000
_+2 _ x+00000003135_ y+00000015221_ z+00000004277
_+3 _ x+00000003993_ y+00000009992_ z-00000000096
_+4 _ x+00000006912_ y+00000007631_ z+00000000407
_+5 _ x+00000002577_ y+00000003569_ z+00000000788
_+6 _ x+00000012071_ y+00000003714_ z-00000000835
_+7 _ x+00000015842_ y+00000001442_ z+00000002275
_+8 _ x+00000021133_ y+00000002553_ z+00000000500
_+9 _ x+00000017531_ y+00000008498_ z-00000001320
_+MARK _ x+00000010000_ y+00000010000_ z+00000000500
_+MARK1 _ x+00000010033_ y+00000009975_ z-00000000959
_+MARK2 _ x+00000010006_ y+00000010001_ z-00000000904
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C-2
_+ST1 _ x+00000013856_ y+00000007047_ z-00000000258
_+ST1-1 _ x+00000013856_ y+00000007047_ z-00000000258
_+ST1-3 _ x+00000013830_ y+00000007105_ z-00000000927
_+ST2 _ x+00000014870_ y+00000010679_ z-00000000204
_+ST2-1 _ x+00000014874_ y+00000010625_ z-00000001005
_+ST2-2 _ x+00000014870_ y+00000010679_ z-00000000204_

GTS-7 Punkt-Koordinatenformat
Name, Rechtswert, Hochwert, Höhe
1,13.37600,9.93900,1.11900,
2,15.22100,3.13500,4.27700,
3,9.99200,3.99300,-0.09600,
4,7.63100,6.91200,0.40700,
5,3.56900,2.57700,0.78800,
6,3.71400,12.07100,-0.83500,
7,1.44200,15.84200,2.27500,
8,2.55300,21.13300,0.50000,
9,8.49800,17.53100,-1.32000,
10,15.98100,18.48200,0.02200,
11,16.99500,15.36000,0.01800,
12,13.37100,13.52000,1.00000,
1113,12.35500,13.12100,-1.88200,
1114,13.91400,10.30700,0.72100,
MARK,10.00000,10.00000,0.50000,
MARK1,9.97500,10.03300,-0.95900,
MARK2,10.00100,10.00600,-0.90400,
ST1,7.04700,13.85600,-0.25800,
ST1-1,7.04700,13.85600,-0.25800,
ST1-3,7.10500,13.83000,-0.92700,
ST2,10.67900,14.87000,-0.20400,
ST2-1,10.62500,14.87400,-1.00500,
ST2-2,10.67900,14.87000,-0.20400,
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Koordinatendateiformate

C-3
Name,E,N,Z,Code-Koordinatenformat
Name, Rechtswert, Hochwert, Höhe, Code
1,13.37600,9.93900,1.11900
2,15.22100,3.13500,4.27700
3,9.99200,3.99300,-0.09600
4,7.63100,6.91200,0.40700
5,3.56900,2.57700,0.78800
6,3.71400,12.07100,-0.83500
7,1.44200,15.84200,2.27500
8,2.55300,21.13300,0.50000
9,8.49800,17.53100,-1.32000
10,15.98100,18.48200,0.02200
11,16.99500,15.36000,0.01800
12,13.37100,13.52000,1.00000
1113,12.35500,13.12100,-1.88200
1114,13.91400,10.30700,0.72100
MARK,10.00000,10.00000,0.50000
MARK1,9.97500,10.03300,-0.95900
MARK2,10.00100,10.00600,-0.90400
ST1,7.04700,13.85600,-0.25800
ST1-1,7.04700,13.85600,-0.25800
ST1-3,7.10500,13.83000,-0.92700
ST2,10.67900,14.87000,-0.20400
ST2-1,10.62500,14.87400,-1.00500
ST2-2,10.67900,14.87000,-0.20400

Name,Lat,Lon,Ht,Code-Koordinatenformat
Name, Lat, Lon, Ht, Code
1,0°00'00.32"N,0°00'00.43"E,1.11900
2,0°00'00.10"N,0°00'00.49"E,4.27700
3,0°00'00.13"N,0°00'00.32"E,-0.09600
4,0°00'00.23"N,0°00'00.25"E,0.40700
5,0°00'00.08"N,0°00'00.12"E,0.78800
6,0°00'00.39"N,0°00'00.12"E,-0.83500
7,0°00'00.52"N,0°00'00.05"E,2.27500
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8,0°00'00.69"N,0°00'00.08"E,0.50000
9,0°00'00.57"N,0°00'00.28"E,-1.32000
10,0°00'00.60"N,0°00'00.52"E,0.02200
11,0°00'00.50"N,0°00'00.55"E,0.01800
12,0°00'00.44"N,0°00'00.43"E,1.00000
1113,0°00'00.43"N,0°00'00.40"E,-1.88200
1114,0°00'00.34"N,0°00'00.45"E,0.72100
MARK,0°00'00.33"N,0°00'00.32"E,0.50000
MARK1,0°00'00.33"N,0°00'00.32"E,-0.95900
MARK2,0°00'00.33"N,0°00'00.32"E,-0.90400
ST1,0°00'00.45"N,0°00'00.23"E,-0.25800
ST1-1,0°00'00.45"N,0°00'00.23"E,-0.25800
ST1-3,0°00'00.45"N,0°00'00.23"E,-0.92700
ST2,0°00'00.49"N,0°00'00.35"E,-0.20400
ST2-1,0°00'00.49"N,0°00'00.34"E,-1.00500
ST2-2,0°00'00.49"N,0°00'00.35"E,-0.20400

Name,E,N,Z,Code-Koordinatenformat
Name, N, E, Z, Code 
1,9.93900,13.37600,1.11900
2,3.13500,15.22100,4.27700
3,3.99300,9.99200,-0.09600
4,6.91200,7.63100,0.40700
5,2.57700,3.56900,0.78800
6,12.07100,3.71400,-0.83500
7,15.84200,1.44200,2.27500
8,21.13300,2.55300,0.50000
9,17.53100,8.49800,-1.32000
10,18.48200,15.98100,0.02200
11,15.36000,16.99500,0.01800
12,13.52000,13.37100,1.00000
1113,13.12100,12.35500,-1.88200
1114,10.30700,13.91400,0.72100
MARK,10.00000,10.00000,0.50000
MARK1,10.03300,9.97500,-0.95900
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C-5
MARK2,10.00600,10.00100,-0.90400
ST1,13.85600,7.04700,-0.25800
ST1-1,13.85600,7.04700,-0.25800
ST1-3,13.83000,7.10500,-0.92700
ST2,14.87000,10.67900,-0.20400
ST2-1,14.87400,10.62500,-1.00500
ST2-2,14.87000,10.67900,-0.20400

Rohdaten-Dateiformate

GTS-6 Rohformat
Für weitere Hinweise ziehen Sie bitte die Bedienungsanleitung 
der GTS-6 Schnittstelle zu Rate.
_'MARK_(STAT_)1.52000_+ST1_ W+000049020m09757060-
03726440d+0000138560+0000070470-
0000002580***+0000+000000_*STAT_,1.60000_+ST1_ 
W+000049040m09757060-03726440d+0000138560+0000070470-
0000002580***+0000+000000_*STAT_,1.60000_+ST2_ 
W+000049560m09713460+00756170d+0000148700+0000106790-
0000002040***+0000+000000_*STAT_,1.60000_+ST2_ 
W+000049560m09713470+00756170d+0000148700+0000106790-
0000002040***+0000+000000_*STAT_,1.60000_+1_ 
?+00003448m0781803+0910223d+00003376***+00+00000_*TREE_,1.600
00_+2_ 
?+00009448m0655422+1424456d+00008625***+00+00000_*TREE_,1.600
00_+3_ ?+00006029m0945426-
1795529d+00006007***+00+00000_*TREE_,1.60000_+4_ 
?+00003892m0901125-
1423025d+00003892***+00+00000_*TREE_,1.60000_'ST1-
1_(STAT_)1.52000_+MARK1_ 
W+000048540m09720510+14233160d+0000100330+0000099750-
0000009590***+0000+000000_*STAT_,1.60000_+MARK1_ 
W+000048560m09720510+14233160d+0000100330+0000099750-
0000009590***+0000+000000_*STAT_,1.60000_+ST2-1_ 
W+000037800m10010080+07407150d+0000148740+0000106250-
0000010050***+0000+000000_*STAT_,1.60000_+ST2-1_ 
W+000037790m10010080+07407150d+0000148740+0000106250-
0000010050***+0000+000000_*STAT_,1.60000_+5_ 
?+00011857m0843301-
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1625151d+00011803***+00+00000_*TREE_,1.60000_+6_ 
?+00003813m0972903-
1181002d+00003781***+00+00000_*TREE_,1.60000_+7_ 
?+00006496m0661635-
0702932d+00005947***+00+00000_*TREE_,1.60000_+8_ 
?+00008594m0842419-
0314150d+00008553***+00+00000_*TREE_,1.60000_'ST2-
2_(STAT_)1.52000_+MARK2_ W+000049500m09711260-
17203440d+0000100060+0000100010-
0000009040***+0000+000000_*STAT_,1.60000_+MARK2_ 
W+000049500m09711250-17203440d+0000100060+0000100010-
0000009040***+0000+000000_*STAT_,1.60000_+ST1-3_ 
W+000037770m09947420-10613530d+0000138300+0000071050-
0000009270***+0000+000000_*STAT_,1.60000_+ST1-3_ 
W+000037770m09947410-10613530d+0000138300+0000071050-
0000009270***+0000+000000_*STAT_,1.60000_+9_ 
?+00003593m1064517-
0392059d+00003441***+00+00000_*TREE_,1.60000_+10_ 
?+00006422m0871605+0554414d+00006415***+00+00000_*TREE_,1.600
00_+11_ 
?+00006342m0871605+0853339d+00006335***+00+00000_*TREE_,1.600
00_+12_ 
?+00003273m0665438+1163803d+00003011***+00+00000_*TREE_,1.600
00_+13_ 
?+00002902m1232505+1361343d+00002422***+00+00000_*TREE_,1.600
00_+14_ 
?+00005683m0794856+1444001d+00005594***+00+00000_*TREE_,1.600
00_

GTS-7 Rohformat
Das allgemeine Format jeder Aufzeichnung ist:
CONTROL WORD    field1,…….,fieldn

JOB Jobname, Beschreibung
DATE Datum, Name
NAME Name des Vermessungsingenieurs
INST Instrumenten-ID
UNITS Meter/Fuß, Grad/Gon
SCALE Gridfaktor, Maßstabfaktor, Höhe
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C-7
ATMOS Temp, Druck
STN ptno, ins ht, stn id
XYZ X(Rechtswert), Y(Hochwert), Z(Höhe)
BKB ptno, Visierrichtung, Visierwinkel
BS ptno[,Zielhöhe]
FS ptno,Zielhöhe, pt code[,string number]
SS ptno,Zielhöhe, pt code[,string number]
CTL Kontrollcode[,pt code 2[,string no 2]](optional)
HV HA, VA
SD HA, VA, SD
HD HA, HD, VD
OFFSET - radialer Offset, tangentialer Offset, vertikaler Offset
NOTE Bemerkungen

XYZ folgt STN Record, falls präsent
BKB folgt BKB Record oder STN Record falls präsent, falls nicht 

BKB
CTL folgt FS oder SS Titelrecord falls präsent
HV,SD,orHD - muss einem BS, FS oder SS Titel folgen und folgt CTL falls 

präsent
OFFSET - kann SD oder HD Record folgen

TTools v1.0
JOB C:\Download\777.raw,Comment
NAME TopconTools
INST TS
UNITS M,D
SCALE 1.000000,1.000000,0.000000
DATE 00/00/00,00:00
TEMP 0.000,000
STN MARK,1.52000,STAT
BKB ST1,0.0000,322.33160
XYZ 13.85600,7.04700,-0.25800
BS ST1,1.60000
SD -37.26440,97.57060,4.90200
SS ST1,1.60000,STAT
SD -37.26440,97.57060,4.90400
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XYZ 13.85600,7.04700,-0.25800
SS ST2,1.60000,STAT
SD 7.56170,97.13460,4.95600
XYZ 14.87000,10.67900,-0.20400
SS ST2,1.60000,STAT
SD 7.56170,97.13470,4.95600
XYZ 14.87000,10.67900,-0.20400
SS 1,1.60000,TREE
SD 91.02230,78.18030,3.44800
SS 2,1.60000,TREE
SD 142.44560,65.54220,9.44800
SS 3,1.60000,TREE
SD -179.55290,94.54260,6.02900
SS 4,1.60000,TREE
SD -142.30250,90.11250,3.89200
STN ST1-1,1.52000,STAT
BKB MARK1,0.0000,142.33160
XYZ 10.03300,9.97500,-0.95900
BS MARK1,1.60000
SD 142.33160,97.20510,4.85400
SS MARK1,1.60000,STAT
SD 142.33160,97.20510,4.85600
XYZ 10.03300,9.97500,-0.95900
SS ST2-1,1.60000,STAT
SD 74.07150,100.10080,3.78000
XYZ 14.87400,10.62500,-1.00500
SS ST2-1,1.60000,STAT
SD 74.07150,100.10080,3.77900
XYZ 14.87400,10.62500,-1.00500
SS 5,1.60000,TREE
SD -162.51510,84.33010,11.85700
SS 6,1.60000,TREE
SD -118.10020,97.29030,3.81300
SS 7,1.60000,TREE
SD -70.29320,66.16350,6.49600
SS 8,1.60000,TREE
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C-9
SD -31.41500,84.24190,8.59400
STN ST2-2,1.52000,STAT
BKB MARK2,0.0000,187.56160
XYZ 10.00600,10.00100,-0.90400
BS MARK2,1.60000
SD -172.03440,97.11260,4.95000
SS MARK2,1.60000,STAT
SD -172.03440,97.11250,4.95000
XYZ 10.00600,10.00100,-0.90400
SS ST1-3,1.60000,STAT
SD -106.13530,99.47420,3.77700
XYZ 13.83000,7.10500,-0.92700
SS ST1-3,1.60000,STAT
SD -106.13530,99.47410,3.77700
XYZ 13.83000,7.10500,-0.92700
SS 9,1.60000,TREE
SD -39.20590,106.45170,3.59300
SS 10,1.60000,TREE
SD 55.44140,87.16050,6.42200
SS 11,1.60000,TREE
SD 85.33390,87.16050,6.34200
SS 12,1.60000,TREE
SD 116.38030,66.54380,3.27300
SS 13,1.60000,TREE
SD 136.13430,123.25050,2.90200
SS 14,1.60000,TREE
SD 144.40010,79.48560,5.68300

GTS-7+ Rohformat
Das GTS-7+ Format ist dem GTS-7 Format ähnlich, speichert 
jedoch nach Berechnung der Koordinaten im Topcon Link auch 
gemessene SideShots-Koordinaten.
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TOPCON XML-Dateiformat
<?xml version="1.0"?>
<Daten>
<Fokuspunkt>
<PunktNummer>1</PunktNummer><Code>TREE</Code></Punkt><Punkt>
<PunktNummer>2</PunktNummer><Code>TREE</Code></Punkt><Punkt>
<PunktNummer>3</PunktNummer><Code>TREE</Code></Punkt><Punkt>
<PunktNummer>4</PunktNummer><Code>TREE</Code></Punkt><Punkt>
<PunktNummer>5</PunktNummer><Code>TREE</Code></Punkt><Punkt>
<PunktNummer>6</PunktNummer><Code>TREE</Code></Punkt><Punkt>
<PunktNummer>7</PunktNummer><Code>TREE</Code></Punkt><Punkt>
<PunktNummer>8</PunktNummer><Code>TREE</Code></Punkt><Punkt>
<PunktNummer>9</PunktNummer><Code>TREE</Code></Punkt><Punkt>
<PunktNummer>10</PunktNummer><Code>TREE</Code></Punkt><Punkt>
<PunktNummer>11</PunktNummer><Code>TREE</Code></Punkt><Punkt>
<PunktNummer>12</PunktNummer><Code>TREE</Code></Punkt><Punkt>
<PunktNummer>13</PunktNummer><Code>TREE</Code></Punkt><Punkt>
<PunktNummer>14</PunktNummer><Code>TREE</Code></Punkt><Punkt>
<PunktNummer>MARK</PunktNummer><Code>STAT</Code></
Punkt><Punkt>
<PunktNummer>MARK1</PunktNummer><Code>STAT</
Code><Hochwert>32.91667</Hochwert><Rechtswert>32.72638</
Rechtswert><Höhe>-3.14633</Höhe></Punkt><Punkt>
<PunktNummer>MARK2</PunktNummer><Code>STAT</
Code><Hochwert>32.82808</Hochwert><Rechtswert>32.81168</
Rechtswert><Höhe>-2.96588</Höhe></Punkt><Punkt>
<PunktNummer>ST1</PunktNummer><Code>STAT</
Code><Hochwert>45.45932</Hochwert><Rechtswert>23.12008</
Rechtswert><Höhe>-0.84646</Höhe></Punkt><Punkt>
<PunktNummer>ST1-1</PunktNummer><Code>STAT</Code></
Punkt><Punkt>
<PunktNummer>ST1-3</PunktNummer><Code>STAT</
Code><Hochwert>45.37402</Hochwert><Rechtswert>23.31037</
Rechtswert><Höhe>-3.04134</Höhe></Punkt><Punkt>
<PunktNummer>ST2</PunktNummer><Code>STAT</
Code><Hochwert>48.78609</Hochwert><Rechtswert>35.03609</
Rechtswert><Höhe>-0.66929</Höhe></Punkt><Punkt>
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<PunktNummer>ST2-1</PunktNummer><Code>STAT</
Code><Hochwert>48.79921</Hochwert><Rechtswert>34.85892</
Rechtswert><Höhe>-3.29724</Höhe></Punkt><Punkt>
<PunktNummer>ST2-2</PunktNummer><Code>STAT</Code></
Punkt><Projekt>
<JobName>C:\Download\x2.xml</JobName><DistanzEinheitIndikator>Fuß</
DistanzEinheitIndikator><WinkelEinheitIndikator>DMS</
WinkelEinheitIndikator><GridFaktor>1.000000</
GridFaktor><Maßstab>1.000000</Maßstab><Höhe>0.000000</Höhe></
Projekt><Station>
<StationPunkt>MARK</StationPukt><StationCode>STAT</
StationCode><InstrumentHöhe>4.98688</InstrumentHöhe><Observation>
<WinkelEinheitIndikator>DMS</
WinkelEinheitIndikator><DistanzEinheitIndikator>Fuß</
DistanzEinheitIndikator><PunktNummer>ST1</PunktNummer><Code1>STAT</
Code1><ObsTyp>Visier</ObsTyp><PrismaHöhe>5.24934</
PrismaHöhe><HorizontalerWinkel>-37.26440</
HorizontalerWinkel><NeigungsStrecke>16.08268</
NeigungsStrecke><HorizontaleDistanz>15.92848</
HorizontaleDistanz><VertikalerWinkel>97.57060</
VertikalerWinkel><VertikaleDistanz>-2.22484</
VertikaleDistanz><Hochwert>45.45932</Hochwert><Rechtswert>23.12008</
Rechtswert><Höhe>-0.84646</Höhe></Observation><VisierPunkt>
<PunktNummer>ST1</PunktNummer><VisierRichtung>0.0000</
VisierRichtung><Code1>STAT</Code1><VisierWinkel>322.33160</
VisierWinkel><Hochwert>45.45932</Hochwert><Rechtswert>23.12008</
Rechtswert><Höhe>-0.84646</Höhe></VisierPunkt><Observation>
<WinkelEinheitIndikator>DMS</
WinkelEinheitIndikator><DistanzEinheitIndikator>Fuß</
DistanzEinheitIndikator><PunktNummer>14</PunktNummer><Code1>TREE</
Code1><ObsTyp>Shotsight</ObsTyp><PrismaHöhe>5.24934</
PrismaHöhe><HorizontalerWinkel>144.40010</
HorizontalerWinkel><NeigungsStrecke>18.64501</
NeigungsStrecke><HorizontaleDistanz>18.35302</
HorizontaleDistanz><VertikalerWinkel>79.48560</
VertikalerWinkel><VertikaleDistanz>3.29677</VertikaleDistanz></
Observation></Station></data>
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DXF-Format
0
ABSCHNITT
  2
9
$CECOLOR
 62
0
  9
$EXTMIN
 10
0.3245
 20
0.3245
  9
$EXTMAX
 10
0.3245
 20
0.3245
  9
$LIMMIN
 10
7.0470
 20
10.0060
  9
$LIMMAX
 10
11.1658
 20
15.0363
  0
ENDSEC
  0
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1_point_names
 70
0
  6
DASHED
 62
255
  0
LAYER
  2
2_comment
 70
0
  6
DASHED1
 62
5
  0
ENDTAB
  0
ENDSEC
  0
ABSCHNITT
BLOCKS
  0
BLOCK
  8
0
  2
MARK1
 70
2
 10
9.9750
 20
10.0330
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 30
-0.9590
  0
POINT
  8
0
 10
9.9750
 20
10.0330
 30
-0.9590
  0
ATTDEF
  8
SEQEND
  0
INSERT
  8
0
 66
1
  2
ST2-1
 10
10.6250
 20
14.8740
 30
-1.0050
  0
SEQEND
  0
ENDSEC
  0
EOF
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LandXML-Dateiformat
<?xml version=”1.0”?>
<LandXML xmlns=”http://www.landxml.org/schema/LandXML-1.0” 
xmlns:xsi=”http://www.w3.org/2001/XMLSchema-instance” 
xsi:schemaLocation=”http://www.landxml.org/schema/LandXML-1.0 http://
www.landxml.org/schema/LandXML-1.0/LandXML-1.0.xsd” version=”1.0” 
date=”10/24/2003” time=”20:30:47” readOnly=”false” language=”English”>
<Project name=””/>
<Einheiten>
<Metric linearUnit=”meter” areaUnit=”squareMeter” volumeUnit=”cubicMeter” 
temperatureUnit=”celsius” pressureUnit=”mmHG” angularUnit=”decimal 
degrees” directionUnit=”decimal degrees”/>
</Units>
<Application name=”TopSurv” manufacturer=”Topcon” version=”1.10” 
desc=”OnBoard Version” manufacturerURL=”www.topcon.com”/>
<CgPoints>
<CgPoint name=”0”>9807019.29622078 973450.31989092 213.271773</
CgPoint>
<CgPoint name=”Auto1”>9806910.67604002 973580.14059322 217.066318</
CgPoint>
<CgPoint name=”Auto2”>9806910.65496200 973580.16603014 217.072248</
CgPoint>
<CgPoint name=”Auto3”>9806910.67343960 973580.14156662 217.069849</
CgPoint>
<CgPoint name=”Topo1”>9806910.66581991 973580.14734168 217.080830</
CgPoint>
<CgPoint name=”Topo2”>9806910.66050706 973580.15343608 217.075792</
CgPoint>
<CgPoint name=”Topo3”>9806910.65094054 973580.16451221 217.072649</
CgPoint>
</CgPoints>
</LandXML>
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GPS-Vektor-Dateiformat
GPS-Vektordateien haben das folgende Format:

Titel
VPP(für Vektor),Name_Point1,Name_Point2, 
dX,dY,dZ,sigma_dX,sigma_dY,sigma_dZ, Y(Hochwert), 
Z(Höhe),cor_XY,cor_XZ,cor_YZ,noteP(für 
Punkt),Nane_Point,Lat(DD MM SS.ss),Lon(DD MM 
SS.ss),Ell.Height

//TopconVectorFormat:v.1,
VPP,s0_8OW0,s2_8HDS,0.499,-1.692,
-0.949,0.002,0.001,0.002,0.763,0.748,0.825
VPP,s0_8OW0,s1_416O,-2.126,0.769,-
0.597,0.002,0.003,0.004,0.450,0.319,0.573
VPP,s1_416O,s2_8HDS,2.683,-2.418,-0.296,0.005,0.005,0.006,0.510,0.482,0.652
VPP,master_8BGG,s0_8OW0,2.489,2.791,
-3.170,0.003,0.005,0.006,0.436,0.099,0.571
VPP,master_8BGG,s1_416O,0.327,3.540,
-3.788,0.003,0.004,0.007,0.457,0.258,0.602
VPP,master_8BGG,s2_8HDS,2.982,1.087,
-4.134,0.003,0.002,0.003,0.764,0.725,0.829
P,master_8BGG,55 33 44.000N,37 55 40.000E,506.774,
P,s0_8OW0,55 33 44.444N,37 58 40.888E,504.980,
P,s1_416O,55 33 44.666N,37 58 40.999E,501.043,
P,s2_8HDS,55 33 44.555N,37 58 40.777E,501.204,
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Gedruckte Dateiformate
Topcon Link kann Koordinaten- oder Rohdaten der Totalstation, 
als auch TopSURV-Dateien drucken.

• Koordinatendatei (Abbildung C-1): 

Abb C-1. Beispiel: Gedrucktes Koordinatendateiformat

• Totalstation Rohdatendatei mit ausgewählten Register Points 
(Abbildung C-2):

Abb C-2. Beispiel: Gedrucktes TS Rohdatendateiformat – Register "Points"
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•  Totalstation Rohdatendatei mit ausgewähltem Register TS Obs 
und aktiviertem linken Feld (Abbildung C-3):

Abb C-3. Beispiel: Gedruckte TS Rohdatendatei – Register "TS Obs", linkes 
Feld

• Totalstation Rohdatendatei mit ausgewähltem Register TS Obs 
und aktiviertem rechten Feld (Abbildung C-4):

Abb C-4. Beispiel: Gedruckte TS Rohdatendatei – Register "TS Obs", rechtes 
Feld

• TopSURV-Datendatei mit ausgewähltem Register Points 
(Abbildung C-5):

Abb C-5. Beispiel: Gedruckte TopSURV-Datei – Register "Points"
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• TopSURV-Datendatei mit ausgewähltem Register GPS 
Occupations (Abbildung C-6):

Abb C-6. Beispiel: Gedruckte TopSURV-Datei – Register "GPS Occupations"

• TopSURV-Datendatei mit ausgewähltem Register TS Obs und 
aktiviertem linkem Feld (Abbildung C-7):

Abb C-7. Beispiel: Gedruckte TopSURV-Datei – Register "TS Obs", linkes Panel

• TopSURV-Datendatei mit ausgewähltem RegisterTS Obs und 
aktiviertem rechten Feld (Abbildung C-8):

Abb C-8. Beispiel: Gedruckte TopSURV-Datei – Register "TS Obs", rechtes Feld
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• TopSURV-Datendatei mit ausgewähltem Register GPS Obs 
(Abbildung C-9):

Abb C-9. Beispiel: Gedruckte TopSURV-Datei – Register "GPS Obs"

• TopSURV-Datendatei mit ausgewähltem Register Codes 
(Abbildung C-10):

Abb C-10. Beispiel: Gedruckte TopSURV-Datei – Register "Codes"
Topcon Topcon Link-Bedienungsanleitung
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	4. Drücken Sie Next. Die Statusleiste zeigt den Fortschritt des Importvorgangs an (Abbildung 2-19).
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	Abb 2-20. Rechter Mausklick auf die Totalstation
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	Abb 2-22. Properties - Register "Advanced"
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	2. Legen Sie im Dialogfeld Properties im Register General die folgenden Informationen fest (Abbildung 2-32) und klicken Sie dann auf Apply:
	Abb 2-32. Properties - Register "General"

	3. Klicken Sie auf Advanced, um Baudrate, Datenbits, Parität, Stopbits und Protokoll einzurichten (Abbildung 2-33). Klicken Sie auf OK, um die Informationen zu übernehmen und das Dialogfeld zu schließen.
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	4. Befolgen Sie alle angegebenen Schritte im Feld Instruction des Dialogfelds Export to Device(Abbildung 2-34), um die Totalstation für das Exportieren von Dateien vorzubereiten.
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	5. Klicken Sie im Dialogfeld Export to Device auf die Schaltfläche Next.
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	7. Klicken Sie auf Open. Überprüfen Sie die Totalstation nach der exportierten Datei (siehe dazu Handbuch der Totalstation).
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	3. Klicken Sie im Dialogfeld Export to Device auf die Schaltfläche Next.
	4. Navigieren Sie im Dialogfeld Select file to upload auf die OAF-Datei für den TPS-Empfänger und wählen Sie diese aus (Abbildung 2-38).
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	2. Klicken Sie im Dialogfeld Properties auf das Register Offset(Abbildung 4-39).
	Abb 4-39. TS Properties - Register "Offset"

	3. Bearbeiten Sie das Feld Offset wie gewünscht.
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	3. Klicken Sie im Dialogfeld Properties auf das Register General(Abbildung 4-51).
	Abb 4-51. Point Properties - Register "General"

	4. Bearbeiten Sie das Feld Name wie gewünscht.
	5. Klicken Sie auf OK, um die Informationen zu übernehmen und das Dialogfeld zu schließen. Klicken Sie auf Apply, um die Informationen zu übernehmen und mit dem Bearbeiten des Punktes weiterzufahren.
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	2. Um die Punktoffsets zu bearbeiten, klicken Sie mit der rechten Maustaste auf den Punkt und wählen Sie im Popup-Menü die Option Properties.
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